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Preface

TheOracle Banking Platform Installation Guide - Silent Installation contains information on silent installation
and configuration of Oracle Banking Platform software and its associated products.

This preface contains the following topics:

n Audience

n Documentation Accessibility

n Organization of the Guide

n Related Documents

n Conventions

Audience
This guide is primarily meant as a step-by-step installationmanual for IT deployment teams and onshore
implementations at client locations to install a complete Oracle Banking Platform system in a UNIX based
environment.

The reader is expected to have an acquaintance with UNIX platform, OracleWebLogic server andOracle
Fusion platform firmware such as Oracle JDeveloper, Oracle OID andOracle SOA Suite.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at
http://www.oracle.com/us/corporate/accessibility/index.html.

Access to Oracle Support

Oracle customers have access to electronic support throughMy Oracle Support. For information, visit
http://www.oracle.com/us/corporate/accessibility/support/index.html#info or visit
http://www.oracle.com/us/corporate/accessibility/support/index.html#trs if you are hearing impaired.

Organization of the Guide
This document contains:

Chapter 1 About This Guide

This chapter provides details about applicability of this guide.

Chapter 2 Getting Started

This chapter presents an overview of Oracle Banking Platform and the installation guide. It alsomentions the
assumptions, limitations and exclusions that this document has been based upon.

Chapter 3 Pre-Installation Configuration

This chapter describes the pre-configuration activities that are to be completed successfully for proper
installation and functioning of Oracle Banking Platform.

Chapter 4 Oracle Banking Platform SOA Media Pack Installation
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This chapter explains the steps involved in the installation, and post installation and configuration of Oracle
Banking Platform SOA (Integration Server) Media pack.

Chapter 5 Oracle Banking Platform Host Media Pack Installation

This chapter explains the steps involved in the installation, and post installation and configuration of Oracle
Banking Platform Host Media Pack.

Chapter 6 Oracle Banking Platform Presentation Media Pack Installation

This chapter explains the steps involved in the installation, and post installation and configuration of Oracle
Banking Platform Presentation (UI) Media Pack.

Chapter 7 Oracle Banking Platform Reference Process Models Media Pack Installation

This chapter explains the steps involved in the installation of Oracle Banking Platform Reference Process
Models Media Pack.

Chapter 8 Oracle BAM Installation using OBP SOA Media Pack

This chapter explains the steps involved in the installation of BAM using OBP SOA (Integration Server) Media
Pack.

Chapter 9 Standalone Database Setup

This chapter explains the steps involved in Oracle Banking Platform Database which are primarily concerned
with importing an existing database dump of the QA database.

Chapter 10 Oracle Banking Platform and IPM Integration

This chapter explains the steps involved in the integration of Oracle Banking Platform andOracle Imaging and
Process Management (IPM).

Chapter 11 OBP and OCH-OSC Integration

This chapter explains the steps required for integration of Oracle Banking Platform with OCH andOSC.

Chapter 12 BIP Datasource Creation

This chapter explains the steps required for Oracle Banking Platform BIP (BI Publisher) datasource creation.

Chapter 13 ODI Configuration

This chapter explains the steps involved in the configuration of ODI using OBP HOSTMedia Pack.

Chapter 14 Swagger UI Deployment

This chapter explains the steps involved in the deployment of Swagger UI on the UI server.

Chapter 15 Monitoring Servers Using Oracle Enterprise Manager

This chapter explains the steps required tomonitor servers using Oracle EnterpriseManager (EM).

Chapter 16 Analytics Configuration

This chapter explains the configuration required to set up analytics

Chapter 17 Post Installation Verification

This chapter explains the steps required to verify the Oracle Banking Platform solution installation.

Chapter 18 Errors and Remedies

This chapter provides information on troubleshooting to help diagnose and remedy some of the problems
encountered during installation of the Oracle Banking Platform.

Chapter 19 Uninstalling the Application
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This chapter explains the process of uninstalling the Oracle Banking Platform.

Related Documents
Formore information, see the following documentation:

n For information necessary for the installation and configuration of integration components to create a
complete solution using Oracle Banking Platform andOracle Documaker, see the installation and
configuration guides at http://docs.oracle.com/cd/E22582_01/e22582_01_index.html.

n Information onOracle FusionMiddleware Install-Config Checklist is available at http://aseng-
wiki.us.oracle.com/asengwiki/display/ASMWArchPM/FMW+Install-Config+Checklist+Page.

n For a comprehensive overview of security, see the Oracle Banking Security Guide.

n For the complete list of licensed products and the third-party licenses included with the license, see the
Oracle Banking Licensing Guide.

n For information related to setting up a bank or a branch, and other operational and administrative
functions, see the Oracle Banking Administrator’s Guide.

n For information related to customization and extension, see the Oracle Banking Extensibility Guide.

n For information on the functionality and features, see the respective Oracle Banking Functional
Overview documents.

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which you
supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.

The following acronyms are used in this document:

Acronym Meaning

ADF Application Development Framework

ATM Automated Teller Machine

BAM Business Activity Monitoring

BIP Business Intelligence Publisher

BPEL Business Process Execution Language

DB or db Oracle Database
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Acronym Meaning

FEPI Front End Processing Interface

HOST Middleware Host Tier

IAM Identity and Access Management

IPM Imaging and Process Management

LDAP Lightweight Directory Access Protocol

OAAM Oracle Adaptive Access Manager

OBEC Oracle Banking Enterprise Collections

OBEO Oracle Banking Enterprise Originations

OBEPM Oracle Banking Enterprise Product Manufacturing

OBP Oracle Banking Platform

ODI Oracle Data Integrator

OEL Oracle Enterprise Linux

OEM Oracle EnterpriseManager

OID Oracle Internet Directory

OIM Oracle Identity Manager

OLTP Online Transaction Processing

OPSS Oracle Platform Security Services

OS Operating System

OSB Oracle Service Bus

POS Point Of Sale

RCU Repository Creation Utility

RPM Reference Process Model

sh Unix Shell file

SOA Service Oriented Architecture Tier

SVN Source Code Version Repository

UI User Interface, that is Presentation Tier

VM Virtual Machine

WLS WebLogic Server
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1 About This Guide

This guide is applicable for the following products:

n Oracle Banking Platform (OBP)

n Oracle Banking Enterprise Product Manufacturing (OBEPM)

n Oracle Banking Enterprise Originations (OBEO)

n Oracle Banking Enterprise Collections (OBEC)

References to Oracle Banking Platform or OBP in this guide apply to all the abovementioned products. The
chapters and sections that are not applicable for any of the products are listed in this chapter.

1.1 Section Not Applicable for Oracle Banking Enterprise
Product Manufacturing
The following section is not applicable for Oracle Banking Enterprise Product Manufacturing.

n Chapter 12 BIP Datasource Creation
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2 Getting Started

This chapter presents an overview of Oracle Banking Platform and the installation guide. It alsomentions the
assumptions, limitations and exclusions that this document has been based upon.

2.1 About Oracle Banking Platform
Oracle Banking Platform (OBP) is a one-stop solution for a bank for its core banking operations, across retail
and business banking operations. It is designed to help banks respond strategically to today's business
challenges, while also transforming their business models and processes to reduce operating costs and
improve productivity across both front and back offices.

OBP provides a unified yet scalable IT solution for a bank tomanage its data and end-to-end business
operations with an enriched user experience. It is a composed set of different modules wherein each of the
modules is serviced by a set of services and other subsystems.

2.2 About This Document
This document guides you through the installation of the core banking application Oracle Banking Platform.
This document guides in deploying the following parts of the application:

n Presentation Server (ADF Presentation UI deployment onWebLogic)

n Application Server (Banking Services hosted onWebLogic)

n Integration Server (Oracle Banking Platform Integration and Approval Processes hosted onOracle
SOA)

n Security Configuration (Seeding security to OID)

n Seed Data Configuration (Seeding data to Core banking OLTP Database Server)

There aremultiple prerequisites that need to be done before the start of the installation. The prerequisites
section lists down the requirements. This document does not attempt to guide you through the prerequisites
installation. The readers are expected to see the appropriate platform documentation to install the
prerequisites.

This document prescribes bareminimum hardware requirements to have a functional application
configuration. The sizing for a production environment is not prescribed here.

Due care has been taken tomake this document as complete as possible. In case of any anomalies please
mail to obp-deployment-support@oracle.com.

There are certain steps in the installation thatmay not be optimal yet. Further releases will optimize the
deployment further.

2.3 Assumptions
It is assumed that the reader is aware of the technologies involved and is capable of installing the prerequisite
software products mentioned in Section 3.1.2 Software Environment.

The following are the assumptions regarding the environment and setup with regard to carrying out this
installation:
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2.4 Limitations

n TheOracle Banking Platform installables are downloaded and copied onto a Linux machine or Linux
VM.

n The reader has taken a remote connection to the Linux machine viaWindows box.

n The reader is able to take an ’ssh’ connection to the servers on which various Oracle Banking Platform
components have to be installed from the Linux machine.

n The user is aware of the process of creating required db schema using RCU prior to initiation of OBP
installation.

2.4 Limitations
Whenever the installation gets aborted or is served a timeout for various reasons, rerun the installation from
the beginning with domain cleanup.

2.5 Exclusions
Though some of the software and products listed in prerequisites sectionmay work onWindows, such
qualification has not been carried out and shall not be the focus of this guide. It is advisable to use the
mentionedOperating System (OS) for the best experience.
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3 Pre-Installation Configuration

This chapter describes the pre-configuration activities that are to be completed successfully for proper
installation and functioning of Oracle Banking Platform.

3.1 Setup Prerequisites
This section lists down the requirements from an environment perspective includingminimum hardware
requirements with Operating System (OS) and themiddleware software products, which the Oracle Banking
Platform solution depends and runs on (for example, Database orWebLogic) or interfaces with (for example,
OID or IPM).

3.1.1 Hardware Environment
Theminimum hardware requirements for Oracle Banking Platform solution to install and function decently are
listed below:

Sr.
No.

CPU
(2+GHz)

RAM
(GB) Disk (GB) OS Version Purpose

1 4 16 200 OEL 6.8 or OEL
7.0

Oracle Banking Platform Oracle
Database

2 4 32 200 OEL 6.8 or OEL
7.0

Oracle Banking Platform ADF UI
Presentation Server

3 4 32 200 OEL 6.8 or OEL
7.0

Oracle Banking Platform Services
Middleware Host Server

4 2 16 200
As per OID
certification
matrix.

Oracle OID Server

5 2 16 200
As per IPM
certification
matrix.

Oracle IPM Server

6 2 16 200
As per BIP
certification
matrix.

Oracle BIP Server

7 4 32 200
As per SOA
certification
matrix.

Oracle SOA Server

8 4 16 200
As per BAM
certification
matrix.

Oracle BAM Server

Table 3–1 Hardware and OS

3.1.2 Software Environment
It is assumed that the following products are installed and are available on the server on which the Oracle
Banking Platform installation will be performed.
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3.1 Setup Prerequisites

3.1.2.1 Certification Details
The following software aremandatory:

Sr. No. Components Zone Software

01 OBP UI
Presentation

Banking
App

Oracle FusionMiddleware Infrastructure 12c (12.2.1.2.0)
(This comes along with weblogic-12.2.1.2.0)
Java Version jdk1.8.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

02 SOA
Banking
App

Oracle SOA Suite and Business Process Management
12c (12.2.1.2.0) (This comes along with weblogic-
12.2.1.2.0)
Java Version jdk1.8.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

03 OBP HOST
Banking
App

Oracle FusionMiddleware Infrastructure 12c (12.2.1.2.0)
(This comes along with weblogic-12.2.1.2.0)
Oracle Database 12c Enterprise Edition Release
12.1.0.2.0
Java Version jdk1.8.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

04 OID Security

Oracle Internet Directory (IDM Suite) 11.1.1.9
OracleWeblogic Server 10.3.6
Java Version jdk1.7.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

05 BIP Document

Oracle Business Intelligence 12c (12.2.1.2.0)
Oracle FusionMiddleware Infrastructure 12c (12.2.1.2.0)
(for weblogic)
Java Version jdk1.8.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

06 IPM Document

OracleWebCenter - Content 11.1.1.9
OracleWeblogic Server 10.3.6
Java Version jdk1.7.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

07 OSB Integration
Oracle Service Bus 12c (12.2.1.2.0)
Java Version jdk1.8.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

08 ODI Integration
Oracle Data Integrator 12c (12.2.1.2.0)
Java Version jdk1.8.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

09 OIM Security
Oracle IAM 11.1.2.3 Suite
OracleWeblogic Server 10.3.6
Java Version jdk1.7.0_xx

Table 3–2 List of Software
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3.1 Setup Prerequisites

Sr. No. Components Zone Software

Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

10 OAAM Security

Oracle IAM 11.1.2.3 Suite
OracleWeblogic Server 10.3.6
Java Version jdk1.7.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

11 OAM Security

Oracle IAM 11.1.2.3 Suite
OracleWeblogic Server 10.3.6
Java Version jdk1.7.0_xx
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

12 OEM Management
Oracle EnterpriseManager 12.1.0.4.0
As per certificationmatrix of Oracle EnterpriseManager
12.1.0.4.0

13 EM Agent
Installation Management Push from OEMConsole

14 OBP Database Database
Oracle Database 12c Enterprise Edition Release
12.1.0.2.0
Oracle Linux 6.8 64-bit or Oracle Linux 7.0 64-bit

15 HTTP Server Web Server Oracle HTTP Server 11.1.1.9.0.

16 BAM Banking App

Oracle SOA Suite and Business Process Management
12c (12.2.1.2.0) (This comes along with weblogic-
12.2.1.2.0)
Java Version jdk1.8.0_xx

The following are some notes related to the software.

Serial
Number Description

1
OBP release has been certified with OEL version 6.8 and above (7.0 and 7.1) during the
release cycle. It is strongly recommended to use the versions on which the release is
certified.

2
Oracle Business Intelligence Publisher is required at the time of OBP installation. It is required
to use the actual BIP property values during the installation. This is required as the installer
uploads the OBP reports as onto the BIP server as part of themiddleware host installation
process.

3

ODI_OUTBOUND_USERNAME andODI_OUTBOUND_PASSWORD
TheOBP installer will not abort the installation if this component is not present. It can be
installed later.
However, it is strongly recommended to use the actual property values instead of default
property values during the installation.
Else, the actual values for ODI_OUTBOUND_USERNAME andODI_OUTBOUND_
PASSWORD once available have to bemanually updated in the ’ra/FCRJConnectorODI’ jndi

Table 3–3 Notes
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3.1 Setup Prerequisites

Serial
Number Description

property of com.ofss.fc.app.connector.ear application insidemiddleware host server after the
entire installation completes.

4

TheOBP installer will not abort the installation if this component is not present. It can be
installed later.
It is strongly recommended to use the actual property values instead of default property
values during the installation. Else, these properties have to bemanually updated in Host
Database after the entire installation completes.

5

OIM_OUTBOUND_USERNAME andOIM_OUTBOUND_PASSWORD
TheOBP installer will not abort the installation if this component is not present. It can be
installed later.
It is recommended to use the actual property values instead of default property values during
the installation. Else, these properties have to bemanually updated in Host Database. Also,
actual values for OIM_OUTBOUND_USERNAME andOIM_OUTBOUND_PASSWORD
once available have to bemanually updated in the ’ra/FCRJConnectorOIM’ jndi property of
com.ofss.fc.app.connector.ear application insidemiddleware host server after the entire
installation completes.

6 Oracle Access Manager can be installed later.

7
During installation, password of unix user will be askedmultiple times for “scp” “ssh”. There is
a time limit for entering password. If not entered within specified limit, the installation is likely
to exit. User should take care of this.

8
It is mandatory for machine nodes on which OBP UI, Host, and SOA Media pack installation
is planned, to install the Java Cryptography Extensions Unlimited Strength Jurisdiction Policy
Files, to enable additional encryption strengths.

9

Download the jce_policy.zip from Oracle website for the current Java version being used. For
jdk1.8.0_xx, download UnlimitedJCEPolicyJDK8.zip from the following link:
http://www.oracle.com/technetwork/java/javase/downloads/jce8-download-2133166.html
Copy "local_policy.jar" and "US_export_policy.jar" from this zip file in the pathmentioned
below:
JAVA_HOME/jre/lib/security/

10

It is mandatory that the team installing OBP reads and understands the system requirements
and specifications for the fusionmiddleware specified in the following link:
http://docs.oracle.com/html/E77908_01/toc.htm
The url details the system and platform-specific information for Oracle FusionMiddleware 12c
Release 1 (12.2.1.2.0) products.
Changes necessary at a system level for the fusionmiddleware should bemade prior to
executing OBP media packs.
For example, the number of open files should be increased from the default value as specified
in the following link:
http://docs.oracle.com/html/E73100_01/toc.htm#GUID-12CCC4F8-F374-4221-8CCE-
048834575243

11 SOA managed servers may need the default value raised at operating system level to run, as
it needs to load a large number of OBP application binaries.

12 It is mandatory for SOA Suite to be installed in machine nodes on which OBP BAM
Installation is planned.

35 | Oracle Banking Platform Installation Guide - Silent Installation

http://www.oracle.com/technetwork/java/javase/downloads/jce8-download-2133166.html
http://docs.oracle.com/html/E77908_01/toc.htm
http://docs.oracle.com/html/E73100_01/toc.htm#GUID-12CCC4F8-F374-4221-8CCE-048834575243
http://docs.oracle.com/html/E73100_01/toc.htm#GUID-12CCC4F8-F374-4221-8CCE-048834575243


3.1 Setup Prerequisites

Serial
Number Description

13
The value of property SOA_SERVER_NAME in installer properties should not be changed.
The default value of soa_server1, that is shipped along with media pack, should be retained
AS IS. Managed servers, that are required inside the cluster as per the naming onsite
conventions, should be added after themedia pack installation is complete.

3.1.2.2 Optional
The following software is optional:

n Oracle VM server release 2.2.0

3.1.2.3 Patching
OPatch is a patching utility in OBP Installer. The following is required to run OPatch.

The Python packages need to be installed in the same order as mentioned below. They have to be installed as
root user in UI, Host, and SOA Machines.

n Suds-0.4 (to create webservice client)

n docutils-0.12 (prerequisite for SOAPpy)

n wstools-0.4.3 (prerequisite for SOAPpy)

n SOAPpy0.12.5 (to make SOAP webservice call)

n PyYAML-3.11 (to read yaml file)

n Jypye1-0.5.7 (to call java code from Python)

The abovementioned packages are available in the form of .tar.gz files in themedia pack.

The installation steps are as follows:

1. Extract each file so that the above Python packages get installed in the same order.

2. Run setup.py file inside extracted folder. (command:python install).

tar -xvzf suds-0.4.tar.gz

tar -xvzf docutils-0.12.tar.gz

tar -xvzf wstools-0.4.3.tar.gz

tar -xvzf SOAPpy-0.12.5.tar.gz

tar -xvzf PyYAML-3.11.tar.gz

tar -xvzf JPype1-0.5.7.tar.gz

chmod -R 777 *

cd suds-0.4

python setup.py install

cd ../docutils-0.12

python setup.py install

cd ../wstools-0.4.3

3 Pre-Installation Configuration | 36



3.2 Configure Variables

python setup.py install

cd ../SOAPpy-0.12.5

python setup.py install

cd ../PyYAML-3.11

python setup.py install

cd ../JPype1-0.5.7

python setup.py install

Please note that the above step is only required to run OPatch (a patching utility available with OBP Installer).

3.2 Configure Variables
Perform the following steps to configure the variables:

1. Modify the TargetDefinition.yaml located at the location <installDir>/patching/config.

2. The IP and port of the target should be of Admin Server and the destination location is the path where
the zip will be extracted which is the patch Stage Path.

3. Modify the PatchConfig.yaml located at the location <installDir>/patching/config.

4. The Session context details such as Bank Code, Channel, TargetUnit, Transaction Branch, UserId
has to be entered.

The wsdl details will be as follows:

${Protocol}://${hostadmin_ip}:${hostadmin_port}/${path_to_
TransactionBlackoutApplicationServiceSpi}?wsdl

For example, url:
http://<Ip>:<Port>/com.ofss.fc.webservice/services/sms/TransactionBlackoutApplicationServiceSpi
?wsdl

5. Modify the PatchConstants.py located at the location <installDir>patching/constants.

a. The PATCH_HOME should point to the Patching Utility.

b. The Deployables Path should point to obp.

c. The FMW_HOME should point to the path till fmw.

d. TheWLST_SCRIPT_LOCATION should point to the wlst.sh (weblogic scripting tool).

e. The JVM_PATH should point to the libjvm.so.

f. The PATCH_TEMP_LOCATION should be the path where the zips are to be stored.

g. The FCServerWithPort is ‘${protocol}://${hostmanagedserver_ip}:${hostManagedServer_port}’.

h. The SOAServerWithPort is ‘${protocol}://${uimanagedserver _ip}:${ uiManagedServer _port}’.

i. The CENTRAL_PATCH_STAGE_PATH should point to the central patch Staging path.

6. Create folder patchStage and centralPatchStage in location <installDir>/.
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3.3 Installation Process Overview

3.3 Installation Process Overview
The following diagram provides an overview of the steps that need to be followed to install and configure
Oracle Banking Platform:

Figure 3–1 Installation Overview

3.4 Installation Checklist
It is mandatory that the team installing OBP reads and understands the system requirements and
specifications for the fusionmiddleware specified in the following link:

http://docs.oracle.com/html/E18558_01/fusion_requirements.htm
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3.4 Installation Checklist

The link details the system and platform-specific information for Oracle FusionMiddleware 12c Release 1
(12.2.1.2.0) products.

Changes necessary at a system level for the fusionmiddleware should bemade prior to executing OBP
media packs.

For example, the number of open files should be increased from the default value as specified in the following
link:

http://docs.oracle.com/html/E18558_01/fusion_requirements.htm#BABFCFIF

Tomake the installation experience quick and easy, a checklist of information is provided, which should be
filled and kept handy. The checklist has beenmademore intuitive and relevant by ensuring that the Key for
properties defined in the installation property file is same as the Name column in the first table of the
checklist.

3.4.1 Updating installobp***.properties
This checklist provides values for updating installobp***.properties.

Figure 3–2 Values for updating installobp***.properties

Sr.No Name Description Example Value Value

1 SILENT_INSTALL
Flag for installing
silent or
interactivemode

y

2 IPM_INSTALLED
Flag tomake
sure IPM is
installed

y

3 BIP_INSTALLED
Flag tomake
sure BIP is
installed

y

4
OID_FARM_AND_
POLICY_SEEDING_
FLAG

Flag for policy
seeding Y

5 BIP_REPORTS_
UPLOADING_FLAG

Flag for BIP
reports uploading Y

6 REMOTE_EXECUTION
Flag for
executing
installer remotely

Y

7 SECURITY_ENABLED Flag for security
enable Y

8 LOCAL_IP

I/P of the local
machine which
could be a
windows
machine on
which software
like XManager is
installed for
rendering UI of a

10.180.84.110
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3.4 Installation Checklist

Sr.No Name Description Example Value Value

utility executing
on a remote
Linux server.

9 LOCAL_DISPLAY_
VALUE

Value of
DISPLAY
variable to be
exported to
generate
installation
wizard in local
machine

0

10 DOMAIN_NAME Weblogic
Domain name

host_domain or ui_domain or base_
domain

11 DOMAIN_DIRECTORY_
LOCATION

Location where
DOMAIN_
NAME folder will
be created

/scratch/app/product/fmw/user_
projects/domains

12 WEBLOGIC_
USERNAME

Username for
weblogic domain weblogic

13 WEBLOGIC_
PASSWORD

Password for
weblogic domain weblogic1

14 ADMIN_SERVER_
LISTEN_ADDRESS

Admin server
listen address

10.180.84.110(Always use i/p , don’t use
localhost)

15 ADMIN_SERVER_
LISTEN_PORT

Admin server
listen port 7001

16 ADMIN_SERVER_SSL_
LISTEN_PORT

Admin server
SSL listen port 7002

17 MANAGED_SERVER_
LISTEN_ADDRESS

Managed server
listen address 10.180.84.110

18 MANAGED_SERVER_
LISTEN_PORT

Managed server
listen port 8001

19 MANAGED_SERVER_
SSL_LISTEN_PORT

SSL listen port
for managed
server

8002

20 LDAP_PROVIDER
Refers to LDAP
Provider .Value
will be OID or
OVD.

OID

21 OID_IP I/P address of
the OID server. 10.180.84.113

22 OID_PORT
Port of the OID
process
instance.

389

23 OID_ADMIN_USER Admin user id cn= orcladmin
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Sr.No Name Description Example Value Value

which can be
used to login of
the OID as
administrator.

24 OID_ADMIN_PWD
Refers to the
password of
admin user of the
OID

welcome1

25 OID_GROUP_DSN
TheDSN used
for object class
Groups in the
OID ldap.

cn=Groups,dc=in,dc=oracle,dc=com

26 OID_USER_DSN
TheDSN used
for object class
Users in the OID
ldap.

cn=Users,dc=in,dc=oracle,dc=com

27 NODE_MGR_PORT

Refers to the
port number to
be used for the
weblogic node
manager. This
port should either
be free on the UI
Presentation
server or an
existing
weblogic node
manager should
be installed to
listen on this port
when the same
is started.

5556

28 HOST_CLUSTER_
NAME

Refers to HOST
cluster name obphost_cluster1

29 HOST_SERVER_NAME Refers to HOST
server name obphost_server1

30 HOST_JAVA_HOME

Refers to the
home directory
of java
installation of the
host machine. 
The version of
java installed
should be 1.8.0
or above. This is
used to execute
the OBP security
policy seeding
utility at the end
of the
installation.

/scratch/app/product/jdk1.8.0_101
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3.4 Installation Checklist

Sr.No Name Description Example Value Value

31 OUI_JAVA_HOME

Refers to the
home directory
of java
installation. The
version of java
installed should
be 1.8.101 . This
is used for OBP
patching.

/scratch/app/product/jdk1.8.0_101

32 CENTRAL_
INVENTORY_LOC

Refers to the
path of central
inventory. This
path is used for
oui patching.

/scratch/app/oraInventory

33 HOST_IP

I/P address of
the server on
which the OBP
host or
middleware layer
should be
installed.

10.180.84.110(Always use i/p , don’t use
localhost)

34 HOST_TARGET

Refers to a
location on the
Host server
where the
installable can
be transferred.
The user id used
for installation of
OBP should
have read, write
and execute
privileges on this
directory.

/scratch/install/target

35 HOST_MW_HOME

Refers to the
middleware
home of the
weblogic
installation on
the Host server.

/scratch/app/product/fmw

36 UI_ADMIN_SERVER_
LISTEN_ADDRESS

Listen address of
UI Admin server 10.180.84.111

37 UI_ADMIN_SERVER_
LISTEN_PORT

Listen port of UI
Admin server 7001

38
UI_MANAGED_
SERVER_LISTEN_
ADDRESS

Listen address of
UI managed
server

10.180.84.111

39
UI_MANAGED_
SERVER_LISTEN_
PORT

Listen port of UI
managed server 8001
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Sr.No Name Description Example Value Value

40
UI_MANAGED_
SERVER_SSL_
LISTEN_PORT

Listen ssl port of
UI managed
server

8002

41 SOA_ORACLE_HOME
Name of Oracle
SOA which is
present in fusion
middleware.

soa

42 SOA_IP i/p address of
SOA machine 10.180.84.112

43 SOA_UNIX_USER Unix username
of SOA machine ofssobp

44 SOA_MW_HOME

Refers to the
middleware
home of the
weblogic
installation on
the SOA server.

/scratch/app/product/fmw

45 SOA_DOMAIN_NAME

Refers to the
middleware
home of the
weblogic
installation on
the SOA server.

base_domain

46
SOA_MANAGED_
SERVER_LISTEN_
ADDRESS

Listen address of
SOA  server 10.180.84.112

47
SOA_ADMIN_
SERVER_LISTEN_
PORT

Listen port of
SOA  Admin
server

7001

48
SOA_MANAGED_
SERVER_LISTEN_
PORT

Listen port of
SOA server 8001

49 SOA_WEBLOGIC_
USERNAME

Username of the
server of SOA
domain

weblogic

50 SOA_WEBLOGIC_
PASSWORD

Password of the
server of SOA
domain

weblogic1

51 UI_IP

I/P address of
the server on
which the OBP
presentation or
UI layer should
be installed.

10.180.84.111

52 UI_UNIX_USER
Linux login user
id used to install
the OBP UI

ofssobp
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Sr.No Name Description Example Value Value

solution.

53 UI_DOMAIN_HOME

Refers to the
domain name to
be used for the
weblogic domain
of the OBP
Presentation
server

/scratch/app/
product
/fmw/user_projects
/domains
/ui_domain

54 INSTALL_AS
Linux login user
id used to install
the OBP
solution.

ofssobp

55 BIP_SERVER_IP
I/P of the BIP
server to host
OBP reports

10.180.84.115

56 BIP_SERVER_PORT
Port of the BIP
server that hosts
OBP reports

9502

57 BIP_UNIX_USER Linux login user
id for BIP server ofssobp

58 BIP_HOME
Oracle BIP
Home directory
on BIP server

/scratch/app/product/fmw/bi

59 BIP_INSTANCE_PATH
Oracle BIP
Instance
directory on BIP
server

/scratch/app/
product/fmw/
user_projects/
domains/bi_domain
/bidata/

60 BIP_SERVER_USER Oracle BIP
server user id weblogic

61 BIP_SERVER_PSWD
Oracle BIP
server user
password

weblogic1

62 BIP_REPORT_BASE_
PATH

Logical Base
Path onOracle
BIP server under
which OBP
reports would be
hosted

OBP2601/R2601INSTALLER

63 BIP_DATASOURCE_
NAME

OBP Host
database user
used by OBP
report to fetch
data for reports

R262_OBP_HOST

64 IPM_UNIX_USER Linux login user
id for IPM server ofssobp
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65 IPM_SERVER_IP

IP of Oracle
Image and
Processing
Server for OBP
Content
Management

10.180.84.114

66 IPM_SERVER_PORT

Port of Oracle
Image and
Processing
Server for OBP
Content
Management

16000

67 IPM_HOME
Oracle IPM
Home directory
on IPM server

/scratch/app/product/fmw/Oracle_ECM1

68 OAAM_SERVER_IP

OAAM server IP
for 2FA.
OAAM_
SERVER_IP
refers to the ip
address of
OAAM Server
(i.e. the IP of
default server
name as
oaam_server_
server1)

oaam-ofss.com

69 OAAM_SERVER_PORT

OAAM server
Port for 2FA.
OAAM_
SERVER_
PORT refers to
the port of
OAAM Server
(default server
name as oaam_
server_server1)

14000

70 OIM_SERVER_IP Oracle Identity
Manager IP oim-ofss.com

71 OIM_SERVER_PORT Oracle Identity
Manager Port 16000

72 OFSAA_SERVER_IP OFSAA Server
IP ofsaa-ofss.com

73 OFSAA_SERVER_
PORT

OFSAA Server
Port 17000

74 DOCUMAKER_
SERVER_IP

i/p address of
Documaker
server

documaker-ofss.com
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75 DOCUMAKER_
SERVER_PORT

Listen port of
Documaker
server

15000

76 BAM_SERVER_NAME Bam sever listen
address bam-ofss.com

77 BAM_SERVER_PORT BAMmanaged
server port 9003

78 ODI_SERVER_NAME ODI server listen
address odi-ofss.com

79 ODI_SERVER_PORT ODI server listen
port 8001

80 OBP_HOST_DB_USER OBP Host
database user R262_OBP_HOST

81 OBP_HOST_DB_
PASSWORD

OBP Host
database
password

welcome1

82 OBP_HOST_DB_IP
OBP Host
database i/p
address

10.180.84.113

83 OBP_HOST_DB_PORT OBP Host
database port 1521

84 OBP_HOST_DB_
SERVICE_NAME

OBP Host
database service
name

P84113A

85 ONS_NODE i/p address of
ONS service 10.180.84.113

86 ONS_PORT Listen port of
ONS service 6250

87 OPSS_HOST_
SCHEMA_USER

OPSS Host
schema user PRDHOST_OPSS

88 OPSS_HOST_
SCHEMA_PASSWORD

OPSS Host
schema
password

welcome1

89 OPSS_HOST_DB_IP OPSS Host DB
IP 10.180.84.113

90 OPSS_HOST_DB_
PORT

OPSS Host DB
Port 1521

91 OPSS_HOST_DB_
SERVICE_NAME

OPSS Host
database service
name

P84113A

92 LOCAL_DATASOURCE STB datasource
schema name PRDHOST_STB
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93 MDS_HOST_DB_USER
MDS schema
user to be used
by UI and Host
domain

UI2601_MDS

94 MDS_HOST_DB_
PASSWORD

MDS schema
Password of
MDS schema
user to be used
by UI and Host
domain

welcome1

95 MDS_HOST_DB_IP

MDS DB IP
address of MDS
schema user to
be used by UI
and Host domain

10.180.84.113

96 MDS_HOST_DB_PORT

MDS db port of
MDS schema
user to be used
by  UI and Host
domain

1521

97 MDS_HOST_DB_
SERVICE_NAME

MDS db service
name of MDS
schema user to
be used by  UI
and Host domain

P84113A

98 OPSS_SOA_SCHEMA_
USER

SOA OPSS
schema name SOA262_OPSS

99 OPSS_SOA_AUDIT_
DBDS

SOA OPSS
Audit schema
name

SOA262_IAU_APPEND

100 OPSS_SOA_AUDIT_
VIEWDS

SOA OPSS
Audit View
schema name

SOA262_IAU_VIEWER

101 OPSS_SOA_SCHEMA_
PASSWORD

Password of
SOA OPSS
schema name

welcome1

102 OPSS_SOA_DB_IP
IP address of
SOA OPSS DB
machine

10.180.84.113

103 OPSS_SOA_DB_PORT Port of SOA
OPSS DB 1521

104 OPSS_SOA_DB_
SERVICE_NAME

Service name of
SOA OPSS DB P84113A

105 HOST_ADMIN_JVM_
PARAMS

Host domain
admin JVM
startup
parameters

-Xms1024m
-Xmx4096m
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106 HOST_MANAGED_
JVM_PARAMS

Host domain
managed JVM
startup
parameters

Xms8g -Xmx8g -XX:NewSize=2048m
-XX:MaxNewSize=4096m
-XX:+UseParNewGC
-XX:
+CMSParallelRemarkEnabled -
XX:+UseConcMarkSweepGC -
XX:CMSInitiatingOccupancyFraction=75

107 KEYSTORE_
PASSWORD

Password for
generating
certificate

welcome1

108 IPM_OUTBOUND_
USERNAME

IPM Username
created in 
connector

weblogic

109 IPM_OUTBOUND_
PASSWORD

Password for the
IPM user in
connector

weblogic1

110 BIP_OUTBOUND_
USERNAME

BIP Username
created in 
connector

weblogic

111 BIP_OUTBOUND_
PASSWORD

Password for the
BIP user in
connector

weblogic1

112 ODI_OUTBOUND_
USERNAME

ODI Username
created in 
connector

weblogic

113 ODI_OUTBOUND_
PASSWORD

Password for the
ODI user in
connector

weblogic1

114 OIM_OUTBOUND_
USERNAME

OIM Username
created in 
connector

weblogic

115 OIM_OUTBOUND_
PASSWORD

Password for the
OIM user in
connector

weblogic1

116 WCM_OUTBOUND_
USERNAME

WCMUsername
created in 
connector

weblogic

117 WCM_OUTBOUND_
PASSWORD

Password for the
WCM user in
connector

weblogic1

118
OFFLINE_CHANNEL_
OUTBOUND_
USERNAME

Offline
Username
created in 
connector

offlineuser

119 OFFLINE_CHANNEL_ Password for the welcome1
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OUTBOUND_
PASSWORD

Offline user in
connector

120
SAML_ISSUER_
OUTBOUND_
USERNAME

SAML ISSUER
Username
created in 
connector

weblogic

121
SAML_ISSUER_
OUTBOUND_
PASSWORD

Password for the
SAML ISSUER
user in connector

weblogic1

122
BPEL_ENCRYPTION_
OUTBOUND_
USERNAME

BPEL_
ENCRYPTION
Username
created in 
connector

weblogic

123
BPEL_ENCRYPTION_
OUTBOUND_
PASSWORD

Password for the
BPEL_
ENCRYPTION
user in connector

weblogic1

124 FTP_IPM_OUTBOUND_
USERNAME

FTP IPM
Username
created in 
connector

weblogic

125 FTP_IPM_OUTBOUND_
PASSWORD

Password for the
FTP IPM user in
connector

weblogic1

126 FTP_BIP_OUTBOUND_
USERNAME

FTP BIP
Username
created in 
connector

weblogic

127 FTP_BIP_OUTBOUND_
PASSWORD

Password for the
FTP BIP user in
connector

weblogic1

128
BIP_USR_
OUTBOUND_
USERNAME

BIP Username
created in 
connector

weblogic

129
BIP_USR_
OUTBOUND_
PASSWORD

Password for the
BIP user in
connector

weblogic1

130
SOA_PURGING_
OUTBOUND_
USERNAME

SOA Username
created in 
connector

weblogic

131
SOA_PURGING_
OUTBOUND_
PASSWORD

Password for the
SOA user in
connector

weblogic1

132 SOA_OUTBOUND_
USERNAME

SOA Username
created in  weblogic

49 | Oracle Banking Platform Installation Guide - Silent Installation



3.4 Installation Checklist

Sr.No Name Description Example Value Value

connector

133 SOA_OUTBOUND_
PASSWORD

Password for the
SOA user in
connector

weblogic1

134
ATMUSER_
OUTBOUND_
USERNAME

ATMUsername
created in 
connector

ATMUser

135
ATMUSER_
OUTBOUND_
PASSWORD

Password for the
ATM user in
connector

welcome1

136
POSUSER_
OUTBOUND_
USERNAME

POS Username
created in 
connector

POSUser

137
POSUSER_
OUTBOUND_
PASSWORD

Password for the
POS user in
connector

welcome1

138
DMSHOST_
OUTBOUND_
USERNAME

DMS HOST
Username
created in 
connector

weblogic

139
DMSHOST_
OUTBOUND_
PASSWORD

Password for the
DMS HOST user
in connector

weblogic1

140 DMSUI_OUTBOUND_
USERNAME

DMS UI
Username
created in 
connector

weblogic

141 DMSUI_OUTBOUND_
PASSWORD

Password for the
DMS UI user in
connector

weblogic1

142 OCH_OUTBOUND_
USERNAME

OCH Username
created in 
connector

weblogic

143 OCH_OUTBOUND_
PASSWORD

Password for the
OCH user in
connector

weblogic1

144 WS_MFT_OUTBOUND_
USERNAME

WS_MFT
Username
created in 
connector

weblogic

145 WS_MFT_OUTBOUND_
PASSWORD

Password for the
WS_MFT user in
connector

weblogic1

146 OP_OUTBOUND_
USERNAME

OP Username
created in  weblogic

3 Pre-Installation Configuration | 50



3.4 Installation Checklist

Sr.No Name Description Example Value Value

connector

147 OP_OUTBOUND_
PASSWORD

Password for the
OP user in
connector

weblogic1

148 ICS_OUTBOUND_
USERNAME

Username for
ICS connector weblogic

149 ICS_OUTBOUND_
PASSWORD

Password for
ICS connector Weblogic1

150 OBDX_OUTBOUND_
USERNAME

Username for
OBDX connector 1518675030085dean.white@test.com

151 OBDX_OUTBOUND_
PASSWORD

Password for
OBDX connector Welcome@1

152 CARD_USERNAME Username of
Card connector orakey

153 CARD_PASSWORD Password of
Card connector welcome1

154 RULE_USERNAME Username of
Rule connector orakey

155 RULE_PASSWORD Password of
Rule connector welcome1

156 BAM_USERNAME Username of
BAM connector weblogic

157 BAM_PASSWORD Password of
BAM connector weblogic1

158 USER_TIMEZONE Time zone entry +5:30

159 HOST_SSL_
PASSWORD

Password for
configuring SSL
in HOST domain

welcome1

160 SILENT_INSTALL
Flag for
executing
installer remotely

y

161 SECURITY_ENABLED Flag for security
enable Y

162 IPM_INSTALLED Flag for if IPM is
installed Y

163 BIP_INSTALLED Flag for if BIP is
installed Y

164 LOCAL_IP

I/P address of
the local
machine which
could be a
windows

10.180.84.111
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machine on
which software
like XManager is
installed for
rendering UI of a
utility executing
on a remote
Linux server.

165 LOCAL_DISPLAY_
VALUE

Value of
DISPLAY
variable to be
exported to
generate
installation
wizard in local
machine

0

166 DOMAIN_NAME Weblogic
Domain name

Host_domain or ui_domain or base_
domain

167 DOMAIN_DIRECTORY_
LOCATION

Location where
DOMAIN_
NAME folder will
be created

/scratch/app/product/fmw/user_
projects/domains

168 WEBLOGIC_
USERNAME

Username for
weblogic domain weblogic

169 WEBLOGIC_
PASSWORD

Password for
weblogic domain weblogic1

170 LOCAL_DATASOURCE
Username of
LOCAL_
DATASOURCE

PRDUI_STB

171 OPSS_UI_SCHEMA_
USER

OPSS UI
schema name PRDUI_OPSS

172 OPSS_UI_SCHEMA_
PASSWORD

OPSS UI
schema
password

Welcome1

173 OPSS_UI_DB_IP OPSS UI DB IP 10.180.84.113

174 OPSS_UI_DB_PORT OPSS UI DB
PORT 1521

175 OPSS_UI_DB_
SERVICE_NAME

OPSS UI DB
SERIVICE
NAME

P84113A

176 MDS_SCHEMA_USER MDS schema
name PRDUI _MDS

177 MDS_SCHEMA_
PASSWORD

Password of
MDS schema welcome1

178 MDS_DB_IP MDS DB IP 10.180.84.113
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179 MDS_DB_PORT MDS DB PORT 1521

180 MDS_DB_SERVICE_
NAME

MDS DB
SERVIVE
NAME

P84113A

181 OPSS_SOA_SCHEMA_
USER

SOA OPSS
Schema name PRDSOA _OPSS

182 OPSS_SOA_AUDIT_
DBDS

SOA OPSS
AUDIT schema
name

PRDSOA_IAU_APPEND

183 OPSS_SOA_AUDIT_
VIEWDS

SOA OPSS
AUDIT VIEWDB
Schema name

PRDSOA_IAU_VIEWER

184 OPSS_SOA_SCHEMA_
PASSWORD

SOA OPSS
password for
above three
OPSS schema

welcome1

185 OPSS_SOA_DB_IP Service name of
UI OPSS DB 10.180.84.113

186 OPSS_SOA_DB_PORT SOA OPSS DB
PORT 1521

187 OPSS_SOA_DB_
SERVICE_NAME

SOA OPSS DB
SERVICE
NAME

P84113A

188 HOST_SCHEMA_USER
OBP Host
Database
username

R262_OBP_HOST

189 HOST_SCHEMA_
PASSWORD

OBP Host
Database
password

welcome1

190 HOST_DB_IP
OBP Host
Database i/p
address

10.180.84.113

191 HOST_DB_PORT
OBP Host
Database listen
port

1521

192 HOST_DB_SERVICE_
NAME

OBP Host
Database
service name

P84113A

193 ONS_NODE i/p address of
ONS service 10.180.84.113

194 ONS_PORT Listen port of
ONS service 6250

195 ADMIN_SERVER_
LISTEN_ADDRESS

Admin server
listen address 10.180.84.111

53 | Oracle Banking Platform Installation Guide - Silent Installation



3.4 Installation Checklist

Sr.No Name Description Example Value Value

196 ADMIN_SERVER_
LISTEN_PORT

Admin server
listen port 7001

197 ADMIN_SERVER_SSL_
LISTEN_PORT

Admin server
SSL listen port 7002

198 MANAGED_SERVER_
LISTEN_ADDRESS

Managed server
listen address 10.180.84.111

199 MANAGED_SERVER_
LISTEN_PORT

Managed server
listen port 8001

200 MANAGED_SERVER_
SSL_LISTEN_PORT

Managed server
SSL listen port 8002

201 LDAP_PROVIDER
Refers to LDAP
Provider .Value
will be OID or
OVD.

OID

202 OID_IP I/P address of
the OID server 10.180.84.113

203 OID_PORT
Port of the OID
process
instance.

389

204 OID_ADMIN_USER

Admin user id
which can be
used to login of
the OID as
administrator.

cn=orcladmin

205 OID_ADMIN_PWD
Refers to the
password of
admin user of the
OID

welcome1

206 OID_GROUP_DSN
TheDSN used
for object class
Groups in the
OID ldap.

cn=Groups,dc=in,dc=oracle,dc=com

207 OID_USER_DSN
TheDSN used
for object class
Users in the OID
ldap.

cn=Users,dc=in,dc=oracle,dc=com

208 NODE_MGR_PORT

Refers to the
port number to
be used for the
weblogic node
manager. This
port should either
be free on the UI
Presentation
server or an
existing
weblogic node

5556
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manager should
be installed to
listen on this port
when the same
is started

209 UI_IP

I/P address of
the server on
which the OBP
presentation or
UI layer should
be installed.

10.180.84.111

210 UI_CLUSTER_NAME Name of UI
Managed Cluster obpui_cluster1

211 UI_SERVER_NAME Name of UI
Managed Server obpui_server1

212 UI_TARGET

Refers to a
location on the
UI server where
the installables
can be
transferred. The
user id of the use
used for
installation of
OBP should
have read, write
and execute
privileges on this
directory.

/scratch/install/target

213 UI_MW_HOME

Refers to the
middleware
home of the
weblogic
installation on
the UI server.

/scratch/app/product/fmw

214 UI_JAVA_HOME

Refers to the
home directory
of java
installation.  The
version of java
installed should
be 1.8.0 or
above. This is
used to execute
the OBP security
policies policy
seeding utility at
the end of the
installation.

/scratch/app/product/jdk1.8.0_101

215 OUI_JAVA_HOME Refers to the /scratch/app/product/jdk1.8.0_101
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home directory
of java
installation. The
version of java
installed should
be 1.8.0 . This is
used for OBP
patching.

216 CENTRAL_
INVENTORY_LOC

Refers to the
path of central
inventory. This
path is used for
oui patching.

/scratch/app/oraInventory

217 INSTALL_AS
Linux  login user
id used to install
the OBP
solution.

ofssobp

218 IPM_UNIX_USER Linux login user
id of IPM server ofssobp

219 IPM_SERVER_IP i/p address of
IPM server 10.180.84.114

220 IPM_SERVER_PORT Listen port of
IPM server 16000

221 IPM_HOME
Oracle IPM
Home directory
on IPM server

/scratch/app/product/fmw/Oracle_ECM1

222 BIP_SERVER_IP i/p address of
BIP server 10.180.84.115

223 BIP_SERVER_PORT Listen port of
BIP server 9502

224 BIP_UNIX_USER Linux login user
id of BIP server ofssobp

225 BIP_HOME
Oracle BIP
Home directory
on BIP server

/scratch/app/product/fmw/bi

226 OAAM_SERVER_IP

OAAM server IP
for 2FA. OAAM_
SERVER_IP
refers to the ip
address of
OAAM Server
(i.e. the IP of
default server
name as oaam_
server_server1)

oaam-ofss.com

227 OAAM_SERVER_PORT OAAM server 14000
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Port for 2FA.

OAAM_
SERVER_
PORT refers to
the port of
OAAM Server
(default server
name as oaam_
server_server1)

228 OIM_SERVER_IP
Oracle Identity
Manager i/p
address

oim-ofss.com

229 OIM_SERVER_PORT
Oracle Identity
Manager Listen
Port

16000

230 OFSAA_SERVER_IP OFSAA Server
i/p address ofsaa-ofss.com

231 OFSAA_SERVER_
PORT

OFSAA Server 
listen port 17000

232 UI_ADMIN_JVM_
PARAMS

UI domain admin
JVM startup
parameters

-Xms2048m
-Xmx4096m

233 UI_MANAGED_JVM_
PARAMS

UI domain
managed JVM
startup
parameters

-Djbo.ampoo
l.doampooling=false
-Xms6g
-Xmx6g
-XX:NewSize=512m
-XX:MaxNewSize =2048m
-XX:+UseParNewGC
-XX:+CMSParallel
RemarkEnabled
-XX:+UseConcMark
SweepGC
-XX:CMSInitiating Occupancy
Fraction=75
-Djbo.load.com
ponents.lazily=true

234
HOST_ADMIN_
SERVER_LISTEN_
ADDRESS

Listen address of
HOST admin
server

10.180.84.110

235
HOST_ADMIN_
SERVER_LISTEN_
PORT

Listen port of
HOST admin
server

7001
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236
HOST_MANAGED_
SERVER_LISTEN_
ADDRESS

Listen address of
host managed
server

10.180.84.110

237
HOST_MANAGED_
SERVER_LISTEN_
PORT

Listen port of
host managed
server

8001

238
SOA_MANAGED_
SERVER_LISTEN_
ADDRESS

Listen address of
SOA server 10.180.84.112

239
SOA_MANAGED_
SERVER_LISTEN_
PORT

Listen port of
SOA server 8001

240
SOA_ADMIN_
SERVER_LISTEN_
ADDRESS

Listen address of
Admin SOA
server

10.180.84.112

241
SOA_ADMIN_
SERVER_LISTEN_
PORT

Listen port of
Admin SOA
server

7001

242 KEYSTORE_
PASSWORD

Password for
generating
certificate

welcome1

243 UI_SSL_PASSWORD
Password for
configuring SSL
in UI domain

welcome1

244 UCM_READ_FROM_
URL

Flag for getting
UCMURL from
properties file.

These values are
used by the
Webcenter
Portal
application for
internet banking. 
Hence values for
UCM_READ_
FROM_URL and
UCM_IP, UCM_
PORT below can
be left as is for
installations,
which do not use
theWebcenter
portal for hosting
their internet
banking
application.

However, as a
best practice, it

true/false
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is recommended
that we configure
values for UCP_
IP and UCM_
PORT correctly
from day 1

245 UCM_IP
UCM_IP the IP
address of the
UCMWebLogic
managed server.

ofss.ucm.com

246 UCM_PORT Port of UCM. 4444

247
OFFLINE_CHANNEL_
OUTBOUND_
USERNAME

Offline username
created in
connector

offlineuser

248
OFFLINE_CHANNEL_
OUTBOUND_
PASSWORD

Password for the
Offlineuser user
in connector

welcome1

249 CARD_USERNAME Username of
Card connector. orakey

250 CARD_PASSWORD Password of
Card connector. welcome1

251 RULE_USERNAME Username of
Rule connector orakey

252 RULE_PASSWORD Password of
Rule connector welcome1

253 USER_TIMEZONE Time zone entry +5:30

254 REMOTE_EXECUTION
Flag for
executing
installer remotely

Y

255 IPM_USERNAME Username of
IPM connector weblogic

256 IPM_PASSWORD Password of
IPM connector weblogic1

257 FTP_IPM_USERNAME
Username of
FTP_IPM
connector

ofssobp

258 FTP_IPM_PASSWORD
Password of
FTP_IPM
connector

ofssobp123

259 FTP_IPM_BATCH_
USERNAME

Username of
FTP_IPM_
BATCH

ofssobp

260 FTP_IPM_BATCH_
PASSWORD

Password of
FTP_IPM_ ofssobp123
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BATCH

261 HOST_UNIX_USER
Linux login user
id for HOST
server

ofssobp

262 HOST_MW_HOME

Refers to the
middleware
home of the
weblogic
installation on
the Host server.

/scratch/app/product/fmw

263 SOA_MW_HOME

Refers to the
middleware
home of the
weblogic
installation on
the SOA server.

/scratch/app/product/fmw

264 SOA_DOMAIN_NAME SOA Domain
Name base_domain

265 SILENT_INSTALL
Flag for installing
silent or
interactivemode

y

266 SECURITY_ENABLED Flag for security
enable Y

267 IPM_INSTALLED Flag for if IPM is
installed Y

268 BIP_INSTALLED Flag for if BIP is
installed Y

269 LOCAL_IP

I/P of the local
machine which
could be a
windows
machine on
which software
like XManager is
installed for
rendering UI of a
utility executing
on a remote
Linux server.

10.180.84.112

270 LOCAL_DISPLAY_
VALUE

Value of
DISPLAY
variable to be
exported to
generate
installation
wizard in local
machine

0

271 DOMAIN_NAME Name of the Host_domain or ui_domain or base_
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weblogic domain
to be created domain

272 DOMAIN_DIRECTORY_
LOCATION

Location where
DOMAIN_
NAME folder will
be created

/scratch/app/product/fmw/user_
projects/domains

273 WEBLOGIC_
USERNAME

Username for
weblogic domain weblogic

274 WEBLOGIC_
PASSWORD

Password for
weblogic domain weblogic1

275 MDS_SCHEMA_USER
MDS schema
user for SOA
domain

SOA262_MDS

276
SOA_
INFRASTRUCTURE_
SCHEMA_USER

SOA
infrastructure
schema user for
SOA domain

SOA262_SOAINFRA

277 LOCAL_DATASOURCE
Local schema
user for SOA
domain

SOA262_STB

278 UMS_DATASOURCE
UMS schema
user for SOA
domain

SOA262_UMS

279 DB_SCHEMA_
PASSWORD

Password for
MDS schema
user

welcome1

280 DB_IP
i/p address of
MDS db
machine

10.180.84.113

281 DB_PORT Port of MDS db
port 1521

282 DB_SERVICE_NAME Service Name of
MDS user P84113A

283 HOST_SCHEMA_USER
OBP Host
Database
username

R262_OBP_HOST

284 HOST_SCHEMA_
PASSWORD

OBP Host
Database
password

welcome1

285 HOST_DB_IP
OBP Host
Database i/p
address

10.180.84.113

286 HOST_DB_PORT OBP Host
Database port 1521
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Sr.No Name Description Example Value Value

287 HOST_DB_SERVICE_
NAME

OBP Host
Database
service name

P84113A

288 ONS_NODE i/p address of
ONS service 10.180.84.113

289 ONS_PORT Port of ONS
service 6250

290 OPSS_SOA_SCHEMA_
USER

SOA OPSS
SchemaName SOA262_OPSS

291 OPSS_SOA_AUDIT_
DBDS

SOA OPSS
AUDIT Schema
name

SOA262_IAU_APPEND

292 OPSS_SOA_AUDIT_
VIEWDS

SOA OPSS
AUDIT VIEWDS
Schema name

SOA262_IAU_VIEWER

293 OPSS_SOA_SCHEMA_
PASSWORD

Password of
OPSS_SOA_
SCHEMA_
USER

welcome1

294 OPSS_SOA_DB_IP i/p address of
SOA OPSS DB. 10.180.84.113

295 OPSS_SOA_DB_PORT Port of SOA
OPSS DB. 1521

296 OPSS_SOA_DB_
SERVICE_NAME

Service name of
SOA OPSS DB. P84113A

297 ADMIN_SERVER_
LISTEN_ADDRESS

Admin server
listen address 10.180.84.112

298 ADMIN_SERVER_
LISTEN_PORT

Admin server
listen port 7001

299 ADMIN_SERVER_SSL_
LISTEN_PORT

Admin server
SSL listen
address

7002

300 SOA_SERVER_
LISTEN_ADDRESS

Listen address of
SOA server 10.180.84.112

301 SOA_SERVER_
LISTEN_PORT

Listen port of
SOA server 8001

302 SOA_SERVER_SSL_
LISTEN_PORT

SSL Listen port
of SOA server 8002

303
HUMANTASK_
SERVER_LISTEN_
ADDRESS

Listen address of
humantask
server

10.180.84.112

304 HUMANTASK_
SERVER_LISTEN_

Listen port of
humantask 9001
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Sr.No Name Description Example Value Value

PORT server

305
HUMANTASK_
SERVER_SSL_
LISTEN_PORT

SSL listen port of
humantask
server

9002

306 BAM_SERVER_
LISTEN_ADDRESS

Listen address of
BAM server 10.180.84.112

307 BAM_SERVER_
LISTEN_PORT

Listen port of
BAM server 9003

308 BAM_SERVER_SSL_
LISTEN_PORT

SSL Listen port
of BAM server 9004

309
HOST_ADMIN_
SERVER_LISTEN_
ADDRESS

Listen address of
HOST admin
server

10.180.84.110

310
HOST_ADMIN_
SERVER_LISTEN_
PORT

Listen port of
HOST admin
server

7001

311
HOST_MANAGED_
SERVER_LISTEN_
ADDRESS

Listen address of
host managed
server

10.180.84.110

312
HOST_MANAGED_
SERVER_LISTEN_
PORT

Listen port of
host managed
server

8001

313 LDAP_PROVIDER
Refers to LDAP
Provider .Value
will be OID or
OVD.

OID

314 OID_IP I/P address of
the OID server. 10.180.84.113

315 OID_PORT
Port of the OID
process
instance.

389

316 OID_ADMIN_USER

Admin user id
which can be
used to login of
the OID as
administrator.

cn

317 OID_ADMIN_PWD
Refers to the
password of
admin user of the
OID

welcome1

318 OID_GROUP_DSN
TheDSN used
for object class
Groups in the
OID ldap.

cn=Groups,dc=in,dc=oracle,dc=com
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Sr.No Name Description Example Value Value

319 OID_USER_DSN
TheDSN used
for object class
Users in the OID
ldap.

cn=Users,dc=in,dc=oracle,dc=com

320 NODE_MGR_PORT

Refers to the
port number to
be used for the
weblogic node
manager. This
port should either
be free on the UI
Presentation
server or an
existing
weblogic node
manager should
be installed to
listen on this port
when the same
is started

5556

321 SOA_IP i/p address of
SOA server 10.180.84.112

322 SOA_CLUSTER_NAME Cluster name of
SOA server obpsoa_cluster1

323 SOA_SERVER_NAME Server name of
SOA server soa_server1

324 HUMAN_TASK_
CLUSTER_NAME

Cluster name of
Humantask
server

obphumantask_cluster1

325 HUMAN_TASK_
SERVER_NAME

Server name of
Humantask
server

obphumantask_server1

326 SOA_TARGET

Target folder of
SOA machine
where files will
be copied
temporarily
during
installation

/scratch/install/target

327 SOA_JAVA_HOME

Refers to the
home directory
of java
installation of the
SOA machine. 
The version of
java installed
should be 1.8.0
or above. This is
used to execute
the OBP security

/scratch/app/product/jdk1.8.0_101
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Sr.No Name Description Example Value Value

policies policy
seeding utility at
the end of the
installation.

328 OUI_JAVA_HOME

Refers to the
home directory
of java
installation. The
version of java
installed should
be 1.8.0 . This is
used for OBP
patching.

/scratch/app/product/jdk1.8.0_101

329 CENTRAL_
INVENTORY_LOC

Refers to the
path of central
inventory. This
path is used for
oui patching.

/scratch/app/oraInventory/

330 SOA_MW_HOME

Refers to the
middleware
home of the
weblogic
installation on
the SOA server.

/scratch/app/product/fmw

331 UI_IP i/p address of UI
server 10.180.84.111

332 UI_UNIX_USER Linux login user
id for UI server ofssobp

333 UI_DOMAIN_HOME Full path of UI
domain

/scratch/app/
product/fmw/
user_projects/
domains
/ui_domain

334 INSTALL_AS
Linux login user
id used to install
the OBP
solution.

ofssobp

335 SOA_ADMIN_JVM_
PARAMS

SOA domain
admin JVM
startup
parameters

-Xms1024m
-Xmx2048m

336
SOA_
HUMANTASKSERVER_
JVM_PARAMS

SOA domain
human task
server’s JVM
startup
parameters

-Djbo.ampool.
doampooling=false –Xms12g
-Xmx12g
-XX:NewSize=
512m
-XX:MaxNewSize
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Sr.No Name Description Example Value Value

=2048m
-XX:
+UseParNewGC
-XX:+
CMSParallel
RemarkEnabled -XX:+UseConcMark
SweepGC
-XX:CMSInitiating
OccupancyFraction=75
-Dobp.http.
maxRetryCount=1
-Dobp.http
.socketBufferSize=81

337 SOA_MANAGED_JVM_
PARAMS

SOA domain
managed soa
server’s JVM
startup
parameters

-XX:NewSize
=2048m
-XX:MaxNewSize
=4096m
-XX:+UsePa
rNewGC -XX:
+CMSPar
allelRemarkEnabled -XX:+UseCo
ncMarkSweepGC
-XX:CMSInit
iatingOccupancy
Fraction=75
-Xms11g
-Xmx11g

338 KEYSTORE_
PASSWORD

Password for
generating
certificate

welcome1

339
UI_MANAGED_
SERVER_LISTEN_
ADDRESS

i/p address of UI
Managed server 10.180.84.111

340
UI_MANAGED_
SERVER_LISTEN_
PORT

Listen port of UI
Managed server 8001

341 UI_ADMIN_SERVER_
LISTEN_ADDRESS

i/p address of UI
Admin server 10.180.84.111

342 UI_ADMIN_SERVER_
LISTEN_PORT

Listen port of UI
Admin server 7001

343 DEFAULT_BANK_
CODE

Default bank
code will be set 8
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Sr.No Name Description Example Value Value

while configuring
SOA domain

344
DEFAULT_
TRANSACTION_
BRANCH_CODE

Default branch
code will be set
while configuring
SOA domain

89999

345 DEFAULT_TARGET_
UNIT

Default target
unit will be set
while configuring
SOA domain

OBP_BU

346 CARD_USERNAME Username of
Card connector. orakey

347 CARD_PASSWORD Password of
Card connector welcome1

348 RULE_USERNAME Username of
Rule connector orakey

349 RULE_PASSWORD Password of
Rule connector welcome1

350 USER_TIMEZONE Time zone entry +5:30

351 SOA_SSL_PASSWORD
Password for
configuring SSL
in SOA domain

welcome1

352 REMOTE_EXECUTION
Flag for
executing
installer remotely

Y

353 BAM_INSTALLATION

During SOA
installation value
should be ‘N’
During BAM
installation value
should be Y.

N

354 IPM_USERNAME Username of
IPM connector ofssobp

355 IPM_PASSWORD Password of
IPM connector welcome1

356
OFFLINE_CHANNEL_
OUTBOUND_
USERNAME

Username of
offline connector offlineuser

357
OFFLINE_CHANNEL_
OUTBOUND_
PASSWORD

Password of
offline connector welcome1

358 FTP_IPM_USERNAME
Username of
FTP_IPM
connector

ofssobp
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Sr.No Name Description Example Value Value

359 FTP_IPM_PASSWORD
Password of
FTP_IPM
connector

ofssobp123

360 FTP_IPM_BATCH_
USERNAME

Username of
FTP_IPM_
BATCH
connector

ofssobp

361 FTP_IPM_BATCH_
PASSWORD

Password of
FTP_IPM_
BATCH 
connector

ofssobp123

362 SOA_OUTBOUND_
USERNAME

Username of
SOA connector weblogic

363 SOA_OUTBOUND_
PASSWORD

Password of
SOA connector weblogic1

364 IPM_SERVER_IP i/p address of
IPM server 10.180.84.114

365 IPM_UNIX_USER Linux login user
id for IPM server ofssobp

366 IPM_HOME
Oracle IPM
Home directory
on IPM server

/scratch/app/product/fmw/Oracle_ECM1

367 BIP_SERVER_IP
I/P of the BIP
server to host
OBP reports

10.180.84.115

368 BIP_SERVER_PORT
Port of the BIP
server that hosts
OBP reports

9502

369 BIP_UNIX_USER Linux login user
id for BIP server ofssobp

370 BIP_HOME
Oracle BIP
Home directory
on BIP server

/scratch/app/product/fmw/bi

3.4.2 Database and WebLogic Domain Configuration
The following table lists the other information which should be kept handy tomake this installation easy.

Sr. No. Name Description and Example Value

UI and Host Linux
user login details

1. UI / Presentation Linux This is same as INSTALL_AS

Table 3–4 Oracle Banking Platform DB andWebLogic Domain Configuration
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Sr. No. Name Description and Example Value

server user id captured in the checklist above.

2. UI / Presentation Linux
server user password

Password for the user specified
against INSTALL_AS.

3. Host Linux server user id This is same as INSTALL_AS
captured in the checklist above.

4. Host Linux server user
password

Password for the user specified
against INSTALL_AS.

Database Details

5.
IP address of the Oracle
Banking Platform Oracle
DB server

10.180.90.30

6.
Port of the Oracle
Banking Platform Oracle
DB instance

1521

7. Oracle Banking Platform
DB Service Name OBPDB

8. Oracle Banking Platform
DB sys password **********

9. ONS NODE
10.180.90.30, Make sure ons
service is started on DB. This is
applicable for OBP installation and
not applicable for OBEO.

10. ONS Port 6250

Additional UI
Install Checklist

11.
Admin user id and
password for the Oracle
Banking Platform UI
domain.

The default admin user id is
WebLogic. Decide on the password
to be used and note it.

12.

List of port numbers for
the Oracle Banking
Platform UI domain for:
Admin server
HTTP port for managed
server
HTTPS port for managed
server

Default Values
Admin Server Port: 7001
Managed Server http port: 15308
Managed Server https port: 15309

13.

Password for the key
generated to establish
trust between theOracle
Banking Platform UI and
Host.

Decide on the password to be used
and note it. This is required for the
post installation tasks of UI
domain.

14. Password for keystore Decide on the password to be used
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Sr. No. Name Description and Example Value

generated to establish
trust.

and note it. This is required for the
post installation tasks UI domain.

Additional Host
Install Checklist

15.
Admin user id and
password for the Oracle
Banking Platform Host
domain.

The default admin user id is
WebLogic. Decide on the password
to be used and note it.

16.

List of port numbers for
the Oracle Banking
Platform Host domain for:
Admin server
HTTP port for managed
server
HTTPS port for managed
server

Default Values
Admin Server Port: 7001
Managed Server http port: 15308
Managed Server https port: 15309

17.

Password for the key
generated to establish
trust between theOracle
Banking Platform UI and
Host.

This is same as password in row
11. This is required for the post
installation tasks of host domain.

18.
Password for keystore
generated to establish
trust.

This is same as password in row
12. This is required for the post
installation tasks of host domain.

3.5 OID Schema Setup – Custom OBP Schema
This section describes the OID Schema setup which is a pre-installation configuration required for Oracle
Banking Platform setup.

3.5.1 Prerequisite – OID setup
It is assumed that OID 11.1.1.9 is installed with ODSM and configured. We can thereafter proceed to the next
step of setting up theOBP policy store. OID works better when installed onOEL. See Section 3.1.2 Software
Environment for version information of the software products.

3.5.2 Verify the OID installation
This section describes the procedure to verify the OID installation.

3.5.2.1 Start and Verify the OID processes
Log in to the Linux console with user id oracle, navigate to the ’bin’ directory of the OID instance and start
the OID processes using the commands as follows:

For example, if the OID installation is in /oracle/app/product/fmw/asinst_1

cd /oracle/app/product/fmw/asinst_1/bin

./opmnctl startall
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Figure 3–3 Locate the OID Instance

The ./opmnctl startall command should result in a starting opmn and all managed
processesmessage on the screen.

Figure 3–4 Start the OID Instance

After the prompt returns, run the following command to check the status of OID processes:

./opmnctl status

Figure 3–5 Verify the Status of OID Instance

3.5.2.2 OPSS/OID Performance Tuning
The following changes are required in OID before initiating OBP installation:

Parameters

Change the parameter values as provided below.
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Parameter Name Value

orclmaxcc (Number of DB Connections per Server Process) 10

orclserverprocs (Number of OID LDAP Server Processes) 4

orclgeneratechangelog (Change log Generation) 0

orclldapconntimeout (LDAP Connection Timeout) 60

orclmatchdenabled (EnableMatchDN Processing) 0

Table 3–5 Parameter Values to be Changed

Advanced OID tuning

The steps to perform advancedOID tuning are as follows:

1. Create a .ldif file with any name. For example, tune.ldif.

2. Enter the following information in that file and save it:

dn: cn=dsaconfig,cn=configsets,cn=oracle internet directory

changetype: modify

replace: orclecachemaxsize

orclecachemaxsize: 3g

-

replace: orclecachemaxentries

orclecachemaxentries: 500000

Sample tune.ldif file

dn: cn=oid1,cn=osdldapd,cn=subconfigsubentry

changetype: modify

replace: orclserverprocs

orclserverprocs: 4

dn: cn=oid1,cn=osdldapd,cn=subconfigsubentry

changetype: modify

replace: orclmaxcc

orclmaxcc: 10

dn: cn=oid1,cn=osdldapd,cn=subconfigsubentry

changetype: modify

replace: orclgeneratechangelog
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orclgeneratechangelog: 0

dn: cn=oid1,cn=osdldapd,cn=subconfigsubentry

changetype: modify

replace: orclldapconntimeout

orclldapconntimeout: 60

dn: cn=oid1,cn=osdldapd,cn=subconfigsubentry

changetype: modify

replace: orclmatchdenabled

orclmatchdenabled: 0

3. Then in command prompt, navigate to that directory and run it using the following command:

Note

Ensure that ’ldapmodify’ is available on themachine.

$ORACLE_HOME/bin/ldapmodify -h <<OIDIP>> -p <<OIDPORT>> -D
<<OIDUSERNAME>> -w <<OIDPASSWORD>> -f <<FILENAME>>

Example:

$ORACLE_HOME/bin/ldapmodify -h 10.180.25.116 -p 3060 -D cn=orcladmin –w
welcome1 -f tune.ldif

To execute this example, the following environment variables must be set:

ORACLE_HOME

ORACLE_INSTANCE

INSTANCE_NAME

COMPONENT_NAME

Here are some default examples:
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Figure 3–6 Example of environment variables

See theOID Tuning Guide available at http://docs.oracle.com/cd/E23943_
01/core.1111/e10108/oid.htm#ASPER99961

Patch for OID:

Download and apply the patch (13879999) for OID performance from http://support.oracle.com

OPSS Tuning

The steps to perform advancedOPSS tuning are as follows:

1. IDM Database recommendations

a. The following table presents the suggested values of parameters and alter scripts executed in
system for which the user needs to change the parameters.

Sr.
No. DB Property Name

Suggested
Value for
Tuning

Alter Command

1 Process 1500 ALTER SYSTEM SET processes =
1500 SCOPE = spfile;

2 SGA Target 3G ALTER SYSTEM SET sga_target =
3221225472 SCOPE = spfile;

3 Audit Trail None

ALTER SYSTEM SET audit_sys_
operations=FALSE SCOPE =SPFILE;
ALTER SYSTEM SET audit_trail =
NONE SCOPE = spfile;

4 Open Cursor 500 ALTER SYSTEM SET open_cursors =
500 SCOPE = spfile;

5 PGA_Aggregate_Target 1.5GB ALTER SYSTEM SET pga_aggregate_
target = 1610612736 SCOPE = spfile;

6 NLS Sort Binary ALTER SYSTEM SET nls_sort =
BINARY SCOPE = spfile;

Table 3–6 Suggested values for Tuning and Alter Command
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Sr.
No. DB Property Name

Suggested
Value for
Tuning

Alter Command

7 Filesystemio_Options SETALL ALTER SYSTEM SET filesystemio_
options = SETALL SCOPE = spfile;

8 Fast_start_mttr_target 3600 ALTER SYSTEM SET fast_start_mttr_
target = 3600 SCOPE = spfile;

9 db_securefile ALWAYS ALTER SYSTEM SET db_securefile =
ALWAYS SCOPE = spfile;

10 Session_cached_
cursors 500

ALTER SYSTEM SET session_
cached_cursors = 500 SCOPE =
spfile;

11 plsql_code_type NATIVE ALTER SYSTEM SET plsql_code_
type = NATIVE SCOPE = spfile;

12 _b_tree_bitmap_plans false ALTER SYSTEM SET "_b_tree_
bitmap_plans" = FALSE scope=spfile;

13 Memory_target 0 ALTER SYSTEM SETmemory_
target=0 SCOPE = SPFILE;

b. Redo log file.

Allocated Disk Space for Redo Log Files

ALTER DATABASE ADD logfile ('<oradata
directory>/ORA4212/redo01.log') SIZE 4G REUSE;

ALTER DATABASE ADD logfile ('<oradata
directory>/ORA4212/redo02.log') SIZE 4G REUSE;

ALTER DATABASE ADD logfile ('<oradata
directory>/ORA4212/redo03.log') SIZE 4G REUSE;

c. Undo tablespace.

Increase Disk Space Allocated for UNDOTablespace

ALTER DATABASE DATAFILE '<oradata directory>/ORA4212/undotbs01.dbf'
RESIZE 20G NEXT 1G;

2. jps-config.xml (All servers of OBP-UI, OBP-Host, OBP-SOA domains)

a. Remove the following properties from <serviceInstance name="pdp.service"
provider="pdp.service.provider"> in jps_config.xml.

<property
name="oracle.security.jps.runtime.pd.client.policyDistri
butionMode" value="mixed"/>
<property
name="oracle.security.jps.runtime.instance.name"
value="OracleIDM"/>
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<property name="oracle.security.jps.runtime.pd.client.sm_
name" value="OracleIDM"/>
<property
name="oracle.security.jps.policystore.refresh.enable"
value="true"/>

b. Add following properties:

<DOMAIN-HOME>/config/fmwconfig/jps-config.xml

<propertySet name="props.db.1">
<property name="authorization_cache_enabled"
value="true"/>
<property name="connection.pool.min.size" value="20"/>
<property name="connection.pool.max.size" value="40"/>
<property name="connection.pool.provider.type"
value="IDM"/>
<property name="connection.pool.timeout" value="300000"/>
<property name="connection.pool.provider.type"
value="5"/>
<property
name="oracle.security.jps.policystore.rolemember.cache.t
ype" value="STATIC"/>
<property
name="oracle.security.jps.policystore.rolemember.cache.s
trategy" value="NONE"/>
<property
name="oracle.security.jps.policystore.rolemember.cache.s
ize" value="100"/>
<property
name="oracle.security.jps.policystore.policy.lazy.load.e
nable" value="true"/>
<property
name="oracle.security.jps.policystore.policy.cache.strat
egy" value="NONE"/>
<property
name="oracle.security.jps.policystore.policy.cache.size"
value="1000000"/>
<property
name="oracle.security.jps.policystore.refresh.enable"
value="true"/>
<property
name="oracle.security.jps.policystore.refresh.purge.time
out" value="43200000"/>
<property
name="oracle.security.jps.ldap.policystore.refresh.inter
val" value="6000000"/>
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<property
name="oracle.security.jps.policystore.rolemember.cache.w
armup.enable" value="true"/>
</propertySet>

c. All the above properties should also be added in the <pdp.service> service-instance.

<serviceInstance name="pdp.service"
provider="pdp.service.provider">
<description>Runtime PDP service instance</description>
<property name="authorization_cache_enabled"
value="true"/>
<property name="connection.pool.min.size" value="20"/>
<property name="connection.pool.max.size" value="40"/>
<property name="connection.pool.provider.type"
value="IDM"/>
<property name="connection.pool.timeout" value="300000"/>
<property name="connection.pool.provider.type"
value="5"/>
<property
name="oracle.security.jps.policystore.rolemember.cache.t
ype" value="STATIC"/>
<property
name="oracle.security.jps.policystore.rolemember.cache.s
trategy" value="NONE"/>
<property
name="oracle.security.jps.policystore.rolemember.cache.s
ize" value="100"/>
<property
name="oracle.security.jps.policystore.policy.lazy.load.e
nable" value="true"/>
<property
name="oracle.security.jps.policystore.policy.cache.strat
egy" value="NONE"/>
<property
name="oracle.security.jps.policystore.policy.cache.size"
value="1000000"/>
<property
name="oracle.security.jps.policystore.refresh.enable"
value="true"/>
<property
name="oracle.security.jps.policystore.refresh.purge.time
out" value="43200000"/>
<property
name="oracle.security.jps.ldap.policystore.refresh.inter
val" value="6000000"/>
<property
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name="oracle.security.jps.policystore.rolemember.cache.w
armup.enable" value="true"/>
</serviceInstance>

3. adf-config.xml (optional)

In adf-config.xml, maintain authorizationEnforce="true"

4. setDomainEnv.sh

In setDomainEnv.sh file, include the following java properties. These are absolutely necessary, if
authorizationEnforce = true (previous point).

Property Description

-Djps.combiner.optimize=true
This system property is used to cache the protection
domains for a given subject. Setting -
Djps.combiner.optimize=true can improve Java
authorization performance.

-
Djps.combiner.optimize.lazyeval=true

This system property is used to evaluate a subject's
protection domain when a checkPermission occurs.
Setting -
Djps.combiner.optimize.lazyeval=true can
improve Java authorization performance.

-Djps.policystore.hybrid.mode=false
This 'hybrid mode' property is used to facilitate transition
from SUN java.security.Policy to OPSS Java Policy
Provider.

-Djps.authz=ACC
Delegates the call to JDK API
AccessController.checkPermission which can reduce the
performance impact at run time or while debugging.

DUSE_JAAS=false

Djps.auth=ACC
Delegates the call to JDK API
AccessController.checkPermission which can reduce the
performance impact at run time or while debugging

Djps.auth.debug=false Turn off debugging. This is turned on to debug access
denied errors.

Djps.subject.cache.key=5

JPS uses a Subject Resolver to convert a platform subject
to JpsSubject which contains user/enterprise-role
information, as well as ApplicationRole information. This
information is represented as principals in the subject.
Value = 5: Instead of using the whole subject as the key,
this settings uses a subset of the principal set inside the
subject as the key (actually use principals of
WLSUSerImpl type).
This setting will accelerate the cache retrieval operation if
the subject has a large principal set.

Djps.subject.cache.ttl=600000
Cache's Time To Live (TTL) for case '5' (above). This
system property controls how long the cache is valid.

Table 3–7 Properties
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Property Description

When the time expired, the cached value is dumped. The
setting can be controlled by the flag of -
Djps.subject.cache.ttl=xxxx, where 'xxx' is the duration in
milliseconds.
Consider setting the duration of this TTL setting to the
same value as the value used for the group and user cache
TTL inWLS LDAP authenticator.

Example:

JAVA_PROPERTIES="-Djps.combiner.optimize=true -
Djps.combiner.optimize.lazyeval=true -Djps.policystore.hybrid.mode=false
-Djps.authz=ACC ${JAVA_PROPERTIES} ${WLP_JAVA_PROPERTIES}"

export JAVA_PROPERTIES

3.5.2.3 Import OBP Specific LDIF files
If OIM (Oracle Identity Manager) is installed as the user provisioning product, use the ldif files from the
location <HOST_TARGET>. These ldif files do not contain any predefined users and roles other than some
crucial system users that are needed during startup. The privileges of these users are contained. OIM is used
for creation of first user in OBP.

If OIM is not part of the ecosystem and an initial sanity test of the OBP installation is needed, the sample ldif
files present at the location<HOST_TARGET> can be used for creation of Users andGroups. These sample
files can be used directly or can bemodified as per requirements. In production after initial verification these
users have to be removed.

Note

Ensure that ’ldapadd’ and ’ldapmodify’ are available on themachine.

1. Extract the ’host.zip’ to obtain ’obpinstall-host.zip’. It contains ldif.zip and sampleLdif.zip.

2. Extract ldif.zip. It will create a folder named ldif with ldif files or extract sampleLdif.zip, which will
create a folder named ldif, with ldif files as follows:

n jpsroot.ldif

n fcPerson.ldif

n Users.ldif

n Groups.ldif

n WebLogic.ldif

n Administrators.ldif

3. These are to be used and updated in the OID if necessary. The execution commands for uploading
these LDIF files are given below. The execution order must bemaintained as described.
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Sr. No. LDIF File Name Description

1 Jpsroot Creates jpsroot and jpscontext

2 fcPerson Creates fcPerson object class

3 Users Creates OFSSUser

4 Groups Creates OFSS_Role and offlinerole

5 WebLogic Creates WebLogic user

6 Administrators Creates Administrators Group

Table 3–8 Order of Execution

4. DNS should be changed as per the requirement of the bank in the LDIF files for:

n Users

n Groups

n WebLogic

n Administrators

Note

While executing fcPerson.ldif, “value already exist” problemmay
appear in console.

For this problem, the objectClasses value is required to be changed.

It can be found, at the end of the file as:

“add:objectClasses

objectClasses:(2.5.6.47”

To resolve this problem, change the value (default, it is 2.5.6.47) of
object classes, then run it again.

5. Before executing the following commands, navigate to the location where the LDIF files reside (that is,
inside LDIF folder) in Host machine, where OpenLDAP has been installed as mentioned in prerequisite
section.

ldapadd jpsroot.ldif
ldapadd -h $ldapIP -p $ldapPort -D cn=orcladmin -w welcome1 -c -v -f
jpsroot.ldif

ldapmodify fcPerson.ldif
ldapmodify -h $ldapIP -p $ldapPort -D cn=orcladmin -w welcome1 -c -v -f
fcPerson.ldif

ldapadd Users.ldif
ldapadd -h $ldapIP -p $ldapPort -D cn=orcladmin -w welcome1 -c -v -f
Users.ldif
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ldapadd Groups.ldif
ldapadd -h $ldapIP -p $ldapPort -D cn=orcladmin -w welcome1 -c -v -f
Groups.ldif

ldapadd WebLogic.ldif
ldapadd -h $ldapIP -p $ldapPort -D cn=orcladmin -w welcome1 -c -v -f
Weblogic.ldif

ldapadd Administrators.ldif
ldapadd -h $ldapIP -p $ldapPort -D cn=orcladmin -w welcome1 -c -v -f
Administrators.ldif

3.5.2.4 Verify the import using ODSM or JXplorer
The import of Oracle Banking Platform specific LDIF files can be verified using JXplorer.

Figure 3–7 JXplorer
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4 Oracle Banking Platform SOA Media Pack
Installation

This chapter details every step involved in the installation of Oracle Banking Platform SOA (Integration
Server) Media pack. The subsequent section refers to the variable names specified in Section 3.4 Installation
Checklist.

4.1 Installation and Configuration Procedure
This section details the installation procedure for the Oracle Banking Platform SOA Media Pack.

4.1.1 Preparatory Steps
This section lists the preparatory steps required for the Oracle Banking Platform SOA Media Pack installation.

Step 1 Procuring Installables
Download the appropriate SOA media pack from the following location:

http://edelivery.oracle.com/

Step 2 Extracting the Installables
Copy the ’soa.zip’ to a local Linux VM or Linux machine from where the installation will be carried out. Extract
the ’soa.zip’. Three files will be extracted:

n A zip file ’obpinstall-soa.zip’

n The installation script ’installobpsoa.sh’

n The install configuration property file ’installobpsoa.properties’

Step 3 Printing Checklists
Take a printout of the installation checklist mentioned in Section 3.4 Installation Checklist of this guide and
note the values applicable for each point in the last column for ’Value’ so that the same is handy during the
actual installation.

4.1.2 Pre-Installation Steps
This section lists the pre-installation steps required for the Oracle Banking Platform SOA Media Pack
installation.

Step 1 Updating installobpsoa.properties
Navigate to the directory where the files obpinstall-soa.zip, installobpsoa.sh and installobpsoa.properties are
placed and update installobpsoa.properties with relevant values from the checklist.

Step 2 Checklist for a new setup
Before initiating installation, check the following:
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n Pleasemake sure required RCU schemas have been created. For more information, see Section 9.1
Pre-Installation Steps and Section 9.2 Oracle Banking Platform Database Setup – RCU Installation.

n Increase the size of tablespace (at least 6GB and the auto extendmodemust be on) for MDS,
SOAINFRA andOPSS schema used for SOA domain.

n Nodemanager must not be running on the target machine.

n Create a dummy folder named target andmention its path against SOA_TARGET property.

n Values given in installobpui.properties must be correct. At run time, no option is given to change the
values.

n No processes should be running on the ports given in installobpsoa.properties.

n In case of a re-installation ensure that the directory paths against SOA_TARGET and SOA_MW_
HOME specified in installobpsoa.properties are cleaned up for traces of any previous installations, as
the remote shell copy may not be overwriting in case of any residual file left by the previous run.

n Before initiating the installation, ensure that all the values given in installobpsoa.properties are correct.
At the time of installation, the values will only be displayed once for verification, and it will not be
possible to change the values once the installation begins.

Step 3 OS Level Tuning
OBP libraries are usually copied on an NFS mount. During startup a lot of time is spent fetching these libraries
for classloading and resource loading. The last access time on the files gets imprinted on the file metadata,
which actually incurs aWRITE. Since, this is over NFS, this has a performance impact.

Themount points should bemounted using the "noatime" flag to disable updating the access time. This is a
recommended parameter as per FMW MAA shared storageWP.

For more information, see Page 12 of the following document:

http://www.oracle.com/technetwork/database/availability/maa-fmwsharedstoragebestpractices-402094.pdf

4.1.3 Installation Steps
This section lists the installation steps required for the Oracle Banking Platform SOA Media Pack installation.

1. Navigate to the directory where themedia pack files are placed and execute installobpsoa.sh. The
installation script shall echo the values entered in the installobpsoa.properties file and ask for a
confirmation to go ahead with the installation.

2. The installation script automatically triggers the following significant steps using secure remote copy
’scp’ command and remote shell commands execution using the ’ssh’ command.
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4.1 Installation and Configuration Procedure

Figure 4–1 Steps in installobpsoa.sh script

A sample output is given here.

./installobpsoa.sh
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Figure 4–2 Verification of Properties

Figure 4–3 Verification of Properties
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4.1 Installation and Configuration Procedure

Figure 4–4 Confirmation to Proceed Domain Installation (cont.)

3. Verify the value of each property carefully before proceeding.

4. If all values are correct, then enter ’Y’ or ’y’ and press Enter to initiate the installation. The installation
utility performs the installation and domain is created silently.

Figure 4–5 Copying and Extraction of obpinstall-soa.zip
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Figure 4–6 Copying and Extraction of obpinstall-soa.zip

Figure 4–7 Copying and Extraction of obpinstall-soa.zip
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Figure 4–8 Domain Creation Confirmation

4.2 Post Installation Configuration
This section describes the post installation configuration procedure for Oracle Banking Platform SOA Media
Pack.

Checklist for Post Installation Procedure

Before proceeding with the post installation procedure for SOA, ensure the following:

n Create a backup of the existing file setStartupEnv.sh, and rename setStartupEnvSOA.sh to
setStartupEnv.sh Change. This file is present at <middleware home>/ user_
projects/domains/obpsoadomain/bin.

Replace /scratch/app/product/fmw path with your middleware home path.

n Nodemanager is not running on the SOA machine.

n All values in obppostinstallsoa.properties are correct

n OID_DOMAIN_NAME given in obppostinstallsoa.properties must not exist.

n Nodemanager port should be free. You can verify using the following command, where 5556 is the
NodeManager Port.

$netstat -na | grep 5556

Post Installation Configuration

1. Start the Oracle Banking Platform SOA domain adminWebLogic server by executing the
startWebLogic.sh script in the domain directory.

cd <middleware home>
cd user_projects/domains/obpsoadomain/bin
./startWebLogic.sh

2. Enter the username and password when prompted.

3. Start themanaged server – soa_server1.

cd <middleware home>
cd user_projects/domains/obpsoadomain/bin
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./startManagedWebLogic.sh soa_server1 t3://localhost:<admin_
server_port>

Note

Do not run the post-install as soon as SOA server comes up.

Wait until it loads all the processes and displays themessageSOA
platform is running and accepting requests.

Initiate post-install after getting this message in the console.

4. Once the SOA admin andmanaged servers are running, execute the post install script ’obp-soa-post-
install.sh’ created under middleware directory just like other domains.

5. Navigate to themiddleware location and give executable permission to the post install script:

$cd <soa middleware home>
Then execute following script:

$./obp-soa-post-install.sh
A sample output is given here:

Figure 4–9 Starting Post Installation
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Figure 4–10 Starting Post Installation (contd)

Figure 4–11 Starting Post Installation (contd)
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Figure 4–12 Starting Post Installation (contd)

Figure 4–13 SOA Post Installation Completion

6. For monitoring the script run, check the following log files created under the SOA domain directory:

deploy-composite-SOA-WLST.log

post-obp-SOA-WLST.log

post-soa-GrantAndPolicySet-log.log

post-soa-taskflow-grants.log
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update-syncMaxTimeWait.log

obp-soa-install-log.txt
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5 Oracle Banking Platform Host Media Pack
Installation

This chapter details every step involved in the installation of Oracle Banking Platform Host Media pack. The
subsequent section refers to the variable names specified in Section 3.4 Installation Checklist.

5.1 Installation and Configuration Procedure
This section details the installation procedure for the Oracle Banking Platform Host Media Pack.

5.1.1 Preparatory Steps
This section lists the preparatory steps required for the Oracle Banking Platform Host Media Pack installation.

Step 1 Procuring Installables
Download the appropriate host media pack from the following location:

http://edelivery.oracle.com/

Step 2 Extracting the Installables
Copy the ’host.zip’ to a local Linux VM or Linux machine from where the installation will be carried out. Extract
the ’host.zip’. Four files will be extracted:

n A zip file ’obpinstall-host.zip’

n The installation script ’installobphost.sh’

n The install configuration property file ’installobphost.properties’

n A zip file ’em_monitor.zip’ that is used for monitoring (For more information, see Chapter 15Monitoring
Servers Using Oracle EnterpriseManager).

Step 3 Printing Checklists
Take a printout of the installation checklist mentioned in Section 3.4 Installation Checklist of this guide and
note the values applicable for each point in the last column for “Value” so that the same is handy during the
actual installation.

5.1.2 Pre-Installation Steps
This section lists the pre-installation steps required for the Oracle Banking Platform Host Media Pack
installation. The procedure can be started after UI pre-installation steps are executed.

Step 1 Updating installobphost.properties
Navigate to the directory where the files obpinstall-host.zip, installobphost.sh and installobphost.properties
are placed and update installobphost.properties with relevant values from the checklist.

Step 2 Checklist for a new setup
Before initiating installation on a completely new setup, check the following:
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n Pleasemake sure required RCU schemas have been created. For more information, see Section 9.1
Pre-Installation Steps and Section 9.2 Oracle Banking Platform Database Setup – RCU Installation.

n Nodemanager must not be running on the target machine.

n Create a dummy folder named as Target andmention its path against HOST_TARGET property.

n In case of re-installation ensure that the directory paths against DOMAIN_DIRECTORY_LOCATION,
HOST_TARGET and HOST_MW_HOME specified in installobphost.properties are cleaned up for
traces of any previous installations, as the remote shell copy may not be overwriting in case of any
residual file left by the previous run.

n No processes should be running on the port in HOSTmachine given in installobphost.properties.

n Values in installobphost.properties must be correct. At run time no option is given to change them.

n No other schema should exist in db with the same prefix as HOST_DB_SCHEMA_PREFIX specified
in installobphost.properties. OBP_HOST_DB_USER should be given on the basis of HOST_DB_
SCHEMA_PREFIX.

For example, if HOST_DB_SCHEMA_PREFIX is DEV, thenOBP_HOST_DB_USER should be
DEV_OBP.

n OID_DOMAIN_NAME in installobphost.properties shouldmatch with the OID_DOMAIN_NAME given
in installobpui.properties. Any other domain with the same namemust not exist in OID. The domain in
OID will be created in host pre-install.

n OBP_HOST_DB_USER and BIP_DATASOURCE_NAME must be same in installobphost.properties.

n The following schemas aremanually created prior to installation and are available for updation in the
checklist:

l OBP_HOST_DB_USER (by RCU)

n MDS_HOST_DB_USER as updated in installobphost.properties andMDS_SCHEMA_USER as
updated in installobpui.properties should point to the sameMDS db schema.

5.1.3 Installation Steps
This section lists the installation steps required for the Oracle Banking Platform Host Media Pack installation.

1. Navigate to the directory where themedia pack files are placed and execute installobphost.sh. The
installation script shall echo the values entered in the installobpui.properties file and ask for
confirmation to go ahead with the installation.

2. The installation script automatically triggers the following significant steps using secure remote copy
’scp’ command and remote shell commands execution using the ’ssh’ command.
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Figure 5–1 Steps in installobphost.sh script

A sample output is given here.

5 Oracle Banking Platform Host Media Pack Installation | 96



5.1 Installation and Configuration Procedure

Figure 5–2 Verification of Properties

Figure 5–3 Verification of Properties (contd)
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Figure 5–4 Verification of Properties (contd)

Figure 5–5 Verification of Properties (contd)

3. Verify the value of each property carefully before proceeding.

4. If all values are correct, then enter ’Y’ or ’y’ and press Enter to initiate the installation. The installation
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utility performs the installation and domain is created silently.

Figure 5–6 Confirmation and Copying of Installables to Target Machine
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Figure 5–7 Confirmation and Copying of Installables to Target Machine (contd)

Figure 5–8 Confirmation and Copying of Installables to Target Machine (contd)
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5. After copying, there is host DB schema creation and seeding. After extracting the installables, the
domain gets installed and a confirmationmessage is shown.

Figure 5–9 Domain Installation Confirmation

6. After completion of domain installation, it will proceed to seeding.

Figure 5–10 Untar the policyStoreSetup and Copy on destination location

101 | Oracle Banking Platform Installation Guide - Silent Installation



5.1 Installation and Configuration Procedure

Figure 5–11 Untar the policyStoreSetup and Copy on destination location (contd)
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Figure 5–12 Untar the policyStoreSetup and Copy on destination location (contd)
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Figure 5–13 Policy Seeding
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Figure 5–14 Policy Seeding (contd)
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Figure 5–15 BIP Reports Upload
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Figure 5–16 BIP Reports Upload (contd)
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5.1 Installation and Configuration Procedure

Figure 5–17 BIP Reports Upload (contd)

5.1.4 Front End Processing Interface (FEPI) Installation Steps
Following are the basic steps for FEPI installation procedure:

Step 1 Installation
The installer will create a directory structure for FEPI as /scratch/app/product/fmw/obpinstall/obp/fepi

1. Change the paths in FEPI start scripts based on the environment.

2. Modify Start_fepi_atm.sh and Start_fepi_pos.sh located at
/scratch/app/product/fmw/obpinstall/obp/fepi/scripts.

3. Change the property values in channels_atm.properties and channels_pos.properties based on the
environment as follows:

Property Description Example

BANK_CODE Indicates the
bank code BANK_CODE=335

Table 5–1 Properties
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Property Description Example

LISTENER_PORT

The port number
on which FEPI
server accepts
incoming ISO
message
requests

LISTENER_PORT=9999

COMMAND_PORT

The port number
on which FEPI
server accepts
command
message
Note: Need to
specify an
available valid
port number, so
that FEPI starts;
it is a feature of
native code and
currently no
messages are
sent.

COMMAND_PORT=9998

ISO_TRACE_FILE_AREA The location for
ATM Trace logs

ISO_TRACE_FILE_
AREA=/scratch/app/product/fmw/obpinstall
/obp/fepi/logs/ATMTRACE

FNDI.FJ.java.naming.provider.url

The IP address
and port number
on which
WebLogic
accepts
requests

FNDI.FJ.java.naming.provider.url
=t3://10.180.9.108:7001

4. Start ATM and POS FEPI.

5. On prompt enterWebLogic login credentials. For example, $ sh start_fepi_atm.sh.

Step 2 ATM and POS Trace logs
The Trace logs are available in the logs folder. For example, the trace logs can be located at
/oracle/deployables/iut2/fepi/logs.

Additionally, fepi-console and fepi-ofss logs are also stored at the above location for ATM and POS FEPI
server.

Step 3 module.channel or cz.module.channel enabling of logs
This is not related to FEPI, and these logs (host logs) are controlled by logging.xml of theWebLogic server.

Step 4 Multiple Instances
Currently, there are two instances of FEPI which are ATM and POS. Each instance has the following set of
individual files along with the common shared files. For example, for the ATM FEPI server, the files are as
follows:
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File Name Description

channels_atm.properties Configuration file

fepi_atm.logging.xml Logging configuration file

start_fepi_atm.sh Start script

stop_fepi_atm.sh Stop script

Table 5–2 Examples of files

5.2 Post Installation Configuration
This section describes the post installation configuration procedure for Oracle Banking Platform Host Media
Pack. The procedure can be started after UI, SOA pre installation and standalone database setup steps are
executed.

Checklist for Post Installation Procedure

Before proceeding with the post installation procedure for the host, ensure the following:

n Nodemanager is not running and no other process is running on NODE_MGR_PORT.

n Host db schema seeding has been done.

For more information , see Section 9.5 HOST DB Schema Seeding and Section 9.6 System
Configuration DB Update Script Execution

n Execute the following query once Host db schema seeding is completed (This is applicable for OBEC
release):

update FLX_CS_MODULES_ALL set installed_flag='N' where module_code in
('LN','CS','TD','PR');

commit;

n The nodemanager port should be free. You can verify this using the following command, where 5556 is
the NodeManager Port.

$netstat -na | grep 5556

Post Installation Configuration

1. Start the domain adminWebLogic server by executing the startWebLogic.sh script in the host domain
directory.

cd <middleware home>

cd user_projects/domains/obphostdomai/bin

./startWebLogic.sh

2. Enter the username and password to ensure that theWebLogic server starts.
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Figure 5–18 Host Domain Admin Server Credentials

3. Once the server status changes to RUNNING, proceed to execute the post installation script for Host
domain located under middleware. This script performs amultitude of configurations such as:

n Making changes in Oracle Banking Platform config properties to point to the appropriate
integration server (Example: Setting the BIP server URL)

n Setting the security realm properties of WebLogic domain and reassociating the same to the
OID

n Trust configuration setup using the trust keys copied from the SOA domain

Note

Ensure that Oracle IPM application is running as during post install of
Oracle Banking Platform host. There is a call to the same for creating
Oracle Banking Platform content applications.

4. Navigate to themiddleware home and list the files in the directory. A post installation and configuration
script named obp-host-post-install.sh will be listed along with other files and directories.

5. Execute the script using the following command:

./obp-host-post-install.sh

6. For monitoring the script run, check the following log files created under the UI domain directory:

n obp-host-install-log.txt

n obp-host-install-log-py.txt

Note

The output shown here is a sample output andmay vary slightly from
the original output.
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Figure 5–19 Host Domain Post Installation Script Execution
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Figure 5–20 Host Domain Post Installation Script Execution (contd)
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Figure 5–21 Host Domain Post Installation Script Execution (contd)
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Figure 5–22 Host Domain Post Installation Script Execution (contd)
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Figure 5–23 Host Domain Post Installation Script Execution Summary

7. After completion of the host post installation, it will return to the command prompt.

8. Finally inside logging.xml file for managed servers,

for example: /scratch/app/product/fmw/user_projects/domains/host_
domain/config/fmwconfig/servers/obphost_server1/logging.xml

within the following xml tag:

<logging_configuration> <log_handlers> </log_handlers></logging_configuration>

add:

<log_handler name='el-handler' level='TRACE:32'

class='oracle.core.ojdl.logging.ODLHandlerFactory'>

<property name='path' value='${fc.log.dir}/logs/eclipselink.log' />

<property name='maxFileSize' value='10485760' />

<property name='maxLogSize' value='104857600' />

<property name='encoding' value='UTF-8' />

<property name='useThreadName' value='true' />

<property name='supplementalAttributes'

value='J2EE_APP.name,J2EE_MODULE.name,WEBSERVICE.name,WEBSERVICE_
PORT.name,composite_instance_id,component_instance_id,composite_
name,component_name' />

</log_handler>

9. Within the following xml tag:
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<logging_configuration><loggers></loggers></logging_configuration>

add:

<logger name='org.eclipse.persistence' level='TRACE:32'
useParentHandlers='false'>

<handler name='el-handler' />

</logger>

<logger name='javax.persistence' level='TRACE:32'
useParentHandlers='false'>

<handler name='el-handler' />

</logger>

10. Then start the admin andmanaged servers to check the domain configuration status as described in
verification part in Section 17.2 Host Domain Verification.
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6 Oracle Banking Platform Presentation
Media Pack Installation

This chapter details every step involved in the installation of Oracle Banking Platform Presentation (UI) Media
pack. The subsequent section refers to the variable names specified in Section 3.4 Installation Checklist.

6.1 Installation and Configuration Procedure
This section details the installation procedure for the Oracle Banking Platform PresentationMedia Pack.

6.1.1 Preparatory Steps
This section lists the preparatory steps required for the Oracle Banking Platform PresentationMedia Pack
installation.

Step 1 Procuring Installables
Download the appropriate presentationmedia pack from the following location:

http://edelivery.oracle.com/

Step 2 Extracting the Installables
Copy the ’ui.zip’ to a local Linux VM or Linux machine from where the installation will be carried out. Extract
the ’ui.zip’. Three files will be extracted:

n A zip file ’obpinstall-ui.zip’

n The installation script ’installobpui.sh’

n The install configuration property file ’installobpui.properties’

Step 3 Printing Checklists
Take a printout of the installation checklist mentioned in Section 3.4 Installation Checklist of this guide and
note the values applicable for each point in the last column for ’Value’ so that the same is handy during the
actual installation.

6.1.2 Pre-Installation Steps
This section lists the pre-installation steps required for the Oracle Banking Platform PresentationMedia Pack
installation. The procedure can be started after SOA pre-installation steps are executed.

Step 1 Updating installobpui.properties
Navigate to the directory where the files obpinstall-ui.zip, installobpui.sh and installobpui.properties are
placed and update installobpui.properties with relevant values from the checklist.

Step 2 Checklist for a new setup
Before initiating installation on a completely new setup, check the following:
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n Pleasemake sure required RCU schemas have been created. For more information, see Section 9.1
Pre-Installation Steps and Section 9.2 Oracle Banking Platform Database Setup – RCU Installation.

n Nodemanager must not be running on the target machine.

n Create a dummy folder named as Target andmention its path against UI_TARGET property.

n In case of a re-installation ensure that the directory paths against DOMAIN_DIRECTORY_
LOCATION, HOST_TARGET and HOST_MW_HOME specified in installobpui.properties are cleaned
up for traces of any previous installations, as the remote shell copy may not be overwriting in case of
any residual file left by the previous run.

n No processes should be running on the port in HOSTmachine given in installobpui.properties.

n MDS_SCHEMA_USER schema given in the installobpui.properties exists. This should point to the
same schema as MDS_HOST_DB_USER of installobphost.properties.

n Values given in installobpui.properties must be correct. At run time, no option will be given to change
the values.

6.1.3 Installation Steps
This section lists the installation steps required for the Oracle Banking Platform PresentationMedia Pack
installation.

1. Navigate to the directory where themedia pack files are placed and execute installobpui.sh. The
installation script shall echo the values entered in the installobpui.properties file and ask for a
confirmation to go ahead with the installation.

2. The installation script automatically triggers the following significant steps using secure remote copy
’scp’ command and remote shell commands execution using the ’ssh’ command.
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6.1 Installation and Configuration Procedure

Figure 6–1 Steps in installobpui.sh script

A sample output is given here.
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6.1 Installation and Configuration Procedure

Figure 6–2 Confirmation to Proceed Domain Installation
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6.1 Installation and Configuration Procedure

Figure 6–3 Confirmation to Proceed Domain Installation (contd)
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6.1 Installation and Configuration Procedure

Figure 6–4 Confirmation to Proceed Domain Installation (contd)

3. Verify the value of each property carefully before proceeding.

4. If all values are correct, then enter ’Y’ or ’y’ and press Enter to initiate the installation. The installation
utility performs the installation and domain is created silently.
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6.1 Installation and Configuration Procedure

Figure 6–5 Copying and Extraction of obpinstall-ui.zip
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6.1 Installation and Configuration Procedure

Figure 6–6 Copying and Extraction of obpinstall-ui.zip (contd)
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6.2 Post Installation Configuration

Figure 6–7 Domain Creation Confirmation

The above domain configuration process also creates files named obp-ui-post-install.sh and obp-ui-
post-install.py in UI_MW_HOME location which are to be used to perform post installation
configuration as elaborated in Section 6.2 Post Installation Configuration.

6.2 Post Installation Configuration
This section describes the post installation configuration procedure for Oracle Banking Platform Presentation
Media Pack.

Checklist for Post Installation Procedure

Before proceeding with the post installation procedure for UI, ensure the following:

n Nodemanager is not running on the UI machine.

n OID domain given in obppostinstallui.properties must exist in OID. (TheOID domain is created at the
time of host pre-install).

n Nodemanager port should be free. You can verify this using the following command, where 5556 is the
NodeManager Port.

$netstat -na | grep 5556

Post Installation Configuration
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6.2 Post Installation Configuration

1. Start the domain adminWebLogic server by executing the startWebLogic.sh script in the domain
directory.

cd <middleware home>
cd user_projects/domains/obpuidomain/bin
./startWebLogic.sh

2. Enter the username and the password to ensure that theWebLogic server starts up.

Figure 6–8 UI Admin Server Credentials

Figure 6–9 UI Admin Server Running
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6.2 Post Installation Configuration

Figure 6–10 UI Admin Server Running (contd)

3. Once the server status changes to RUNNING proceed to execute the post installation script.

4. Navigate to themiddleware home and list the files in the directory. A post installation and configuration
script named obp-ui-post-install.sh will be listed along with other files and directories.

5. Navigate to the UI middleware location and give executable permission to the post install script:

$cd <ui middleware home>

6. Execute the script using the following commands:

$./obp-ui-post-install.sh
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6.2 Post Installation Configuration

Figure 6–11 Starting Post Installation
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6.2 Post Installation Configuration

Figure 6–12 Starting Post Installation (contd)
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6.2 Post Installation Configuration

Figure 6–13 Continuation of Post-Installation
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6.2 Post Installation Configuration

Figure 6–14 Continuation of Post-Installation (contd)

7. For monitoring the script run check the following log files created under the ui domain directory:

n obp-ui-install-log.txt

n obp-ui-install-log-py.txt
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7 Oracle Banking Platform Reference Process
Models Media Pack Installation

This chapter details the steps involved in the installation of Oracle Banking Platform Reference Process
Models Media pack (Media pack 4).

The business processes that are supported by Oracle Banking Platform (OBP) have been defined using
Oracle BPA –Oracle Business Process Management Version 12.2.1.3.0.

7.1 Pre-Installation Steps
This section lists the pre-installation steps required for the Oracle Banking Platform Reference Process
Models Media Pack.

Themedia pack consists of a zip file that contains all the projects that are part of this release.

To view the process maps, it is mandatory that the Oracle BPM Version 12.2.1.3.0 is installed in the server,
and appropriately configured based on the specific installation needs. For more information, see the Oracle
BPM Installation guide.

Copy the zip file from themedia pack and unzip the contents with the password provided, to a folder on a
server or desktop.

7.2 Installing RPM Process Maps
This section lists the installation steps required for the Reference Process Models Process Maps.

1. Launch theOracle Business Process Composer from a browser, and connect to theWeb Server where
BPM 12.2.1.3.0 has been installed.
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7.2 Installing RPM Process Maps

Figure 7–1 Log in to the OBP Composer

2. Create a new space for the release by clicking the + icon.

Figure 7–2 Create a New Space

3. Provide an appropriate name for the Space in the box. For example, RPM for OBP Release 2.6.2.0.0.
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7.2 Installing RPM Process Maps

Figure 7–3 Name the Space

4. Click theAll Spaces icon in the top left corner. Select Import and then select Import Project.

Figure 7–4 Import Project

5. Select the newly created space and then select the first file from the files that have been unzipped from
themedia pack, as a part of the pre-installation step.
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7.2 Installing RPM Process Maps

Figure 7–5 Select the first file

6. Click OK to import the project.

Figure 7–6 Click OK to Import the Project

7. There aremany projects in each release. Proceed to import all the projects one by one into the space.

8. Once all the projects are imported, you can then provide access rights to your users as per your
organization requirements and norms. Users can now access BPM processes within the projects
according to their access privileges.

The installation process is complete.
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8 Oracle BAM Installation using OBP SOA
Media Pack

This chapter details every step involved in the installation of BAM using OBP SOA (Integration Server) Media
pack. The subsequent section refers to the variable names specified in Section 3.4 Installation Checklist.

It is mandatory not to carry out BAM installation in the samemachine where SOA installation was done.

Note

This section is valid for OBEO andOBP applications.

8.1 Installation and Configuration Procedure
This section details the installation procedure for BAM using OBP SOA Media Pack.

8.1.1 Preparatory Steps
This section lists the preparatory steps required for BAM using OBP SOA Media Pack.

Step 1 Procuring Installables
Download the appropriate SOA media pack from the following location:

http://edelivery.oracle.com/

Step 2 Extracting the Installables
Copy the ’soa.zip’ to a local Linux VM or Linux machine from where the installation will be carried out. Extract
the ’soa.zip’. Three files will be extracted:

n A zip file ’obpinstall-soa.zip’

n The installation script ’installobpsoa.sh’

n The install configuration property file ’installobpsoa.properties’

Step 3 Printing Checklists
Take a printout of the installation checklist mentioned in Section 3.4 Installation Checklist of this guide and
note the values applicable for each point in the last column for Value so that the same is handy during the
actual installation.

8.1.2 Pre-Installation Steps
This section lists the pre-installation steps required for BAM using OBP SOA Media Pack.

Step 1 Updating installobpsoa.properties
Navigate to the directory where the files obpinstall-soa.zip, installobpsoa.sh and installobpsoa.properties are
placed and update installobpsoa.properties with relevant values from the checklist. This should be easy as
the key for properties is same as Name column of the checklist.

Step 2 Checklist for a new setup
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8.1 Installation and Configuration Procedure

Before initiating installation, check the following:

n Nodemanager must not be running on the target machine.

n Create a dummy folder named target andmention its path against HOST_TARGET property.

n Values given in installobpui.properties must be correct. At run time, no option is given to change the
values.

n No processes should be running on the ports given in installobpsoa.properties.

n In case of a re-installation ensure that the directory paths against SOA_TARGET and SOA_MW_
HOME specified in installobpsoa.properties are cleaned up for traces of any previous installations, as
the remote shell copy may not be overwriting in case of any residual file left by the previous run.

n Before initiating the installation, ensure that all the values given in installobpsoa.properties are correct.
At the time of installation, the values will only be displayed once for verification, and it will not be
possible to change the values once the installation begins.

n The property that should bemodified for BAM Pre Installation is as follows:

Property Name Property Value

BAM_INSTALLATION Y or y

Table 8–1 BAM Installation Property

For BAM installation to take place this property should be set to any of the above two values. In case
of SOA Installation, this property is set as N.

8.1.3 Installation Steps
This section lists the installation steps for BAM using OBP SOA Media Pack.

1. Navigate to the directory where themedia pack files are placed and execute installobpsoa.sh. The
installation script shall echo the values entered in the installobpsoa.properties file and ask for a
confirmation to go ahead with the installation.

2. The installation script automatically triggers the following significant steps using secure remote copy
’scp’ command and remote shell commands execution using the ’ssh’ command.
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8.1 Installation and Configuration Procedure

Figure 8–1 Steps in installobpsoa.sh script

A sample output is given here.

./installobpsoa.sh
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8.1 Installation and Configuration Procedure

Figure 8–2 Verification of Properties

Figure 8–3 Verification of Properties
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8.1 Installation and Configuration Procedure

Figure 8–4 Confirmation to Proceed Domain Installation (cont.)

3. Verify the value of each property carefully before proceeding.

4. If all values are correct, then enter ’Y’ or ’y’ and press Enter to initiate the installation. The installation
utility performs the installation and domain is created silently.

Figure 8–5 Copying and Extraction of obpinstall-soa.zip
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8.1 Installation and Configuration Procedure

Figure 8–6 Copying and Extraction of obpinstall-soa.zip

Figure 8–7 Copying and Extraction of obpinstall-soa.zip
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8.1 Installation and Configuration Procedure

Figure 8–8 Domain Creation Confirmation

8.1.3.1 Updating Domain with BAM Template
After domain creation in pre-installation, perform the following steps for updating the domain with BAM
template:

1. Change directory to <MIDDLEWARE_HOME>/oracle_common/common/bin.

2. Execute config.sh. A configuration wizard window appears.

3. In theConfiguration Type page, select the Update an existing domain option.

Figure 8–9 Configuration Type page

8 Oracle BAM Installation using OBP SOA Media Pack | 144



8.1 Installation and Configuration Procedure

4. Click Next.

5. In the Templates page, select theOracle Business Activity Monitoring check box, in theAvailable
Templates section.

Figure 8–10 Templates page

6. Click Next.

7. In the JDBC Data Sources page, verify the database details for Datasources and then click Next.
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8.1 Installation and Configuration Procedure

Figure 8–11 JDBC Data Sources page

8. In theGridLink Oracle RAC Data Sources page, verify the database details for Datasources and
then click Next.
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8.1 Installation and Configuration Procedure

Figure 8–12 GridLink Oracle RAC Data Sources page

9. In the JDBC Data Sources Test page, click Test Selected Connections. The details of the
connection result appears in theConnection Result Log section.
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8.1 Installation and Configuration Procedure

Figure 8–13 JDBC Data Sources Test page

10. Click Next.

11. In theDatabase Configuration Type page, select theRCU Data option in theSpecify
AutoConfiguration Options Using: section.
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8.1 Installation and Configuration Procedure

Figure 8–14 Database Configuration Type page

12. Update the RCU details and then click Get RCU Configuration.

13. If successful, click Next.
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8.1 Installation and Configuration Procedure

Figure 8–15 JDBC Component Schema page

14. Click Next.

15. In the JDBC Component Schema Test page, click Test Selected Connections. The details of the
connection result appear in theConnection Result Log section.
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8.1 Installation and Configuration Procedure

Figure 8–16 JDBC Component Schema Test page

16. If the selected connections are successfully tested, click Next.

17. In theAdvanced Configuration page, select the Topology, Deployments and Services, and File
Store check boxes.
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8.1 Installation and Configuration Procedure

Figure 8–17 Advanced Configuration page

18. Click Next.

19. In theManaged Servers page, update the BAM server details in the Listen Address and Listen Port
columns.
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8.1 Installation and Configuration Procedure

Figure 8–18 Managed Servers page

20. Click Next.
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8.1 Installation and Configuration Procedure

Figure 8–19 Clusters page

21. Click Next.
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8.1 Installation and Configuration Procedure

Figure 8–20 Server Templates page

22. Click Next.

23. In theDynamic Servers page, verify the details and then click Next.
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8.1 Installation and Configuration Procedure

Figure 8–21 Dynamic Servers page

24. In theAssign Servers to Clusters page, assign the BAM server to the cluster.
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8.1 Installation and Configuration Procedure

Figure 8–22 Assign Servers to Clusters page

25. Click Next.

26. In theCoherence Clusters page, check the coherence cluster details and then click Next.
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8.1 Installation and Configuration Procedure

Figure 8–23 Coherence Clusters page

27. In theMachines page, click theUnix Machine tab and update the details.

8 Oracle BAM Installation using OBP SOA Media Pack | 158



8.1 Installation and Configuration Procedure

Figure 8–24 Machines page

28. Click Next.

29. In theAssign Servers to Machines page, assign the BAM server to themachine.
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8.1 Installation and Configuration Procedure

Figure 8–25 Assign Servers to Machines page

30. Click Next.
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8.1 Installation and Configuration Procedure

Figure 8–26 Virtual Targets page

31. Click Next.
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8.1 Installation and Configuration Procedure

Figure 8–27 Partitions page

32. Click Next.
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8.1 Installation and Configuration Procedure

Figure 8–28 Deployments Targeting page

33. Click Next.
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8.1 Installation and Configuration Procedure

Figure 8–29 Services Targeting page

34. Click Next.
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8.1 Installation and Configuration Procedure

Figure 8–30 File Stores page

35. Click Next.

36. In theConfiguration Summary page, check the details and then click Update.
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8.1 Installation and Configuration Procedure

Figure 8–31 Configuration Summary page

37. In theConfiguration Progress page, once the progress bar is 100%, click Next.

38. In theEnd of Configuration page, click Finish.
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8.1 Installation and Configuration Procedure

Figure 8–32 Configuration Progress page
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8.2 Post Installation Configuration

Figure 8–33 End of Configuration page

39. Once the domain is successfully updated, you need tomake the following changes in the config.xml
file located at <MIDDLEWARE_HOME>/user_projects/domains/base_domain/config if the target is
not bam_server1.

<jms-server>
<name>BamCQServiceJmsServer</name>
<target>bam_server1</target>
<persistent-store>BamCQServiceJmsFileStore</persistent-store>
</jms-server>

<file-store>
<name>BamCQServiceJmsFileStore</name>
<directory>BamCQServiceJmsFileStore</directory>
<target>bam_server1</target>
</file-store>

8.2 Post Installation Configuration
This section describes the post installation configuration procedure for BAM using OBP SOA Media Pack.

Checklist for Post Installation Procedure

Before proceeding with the post installation, ensure the following:
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8.2 Post Installation Configuration

1. Apply the grant onmiddleware home throughWLST.

grantPermission(appStripe=None, principalClass=None,
principalName=None, codeBaseURL='file:/<middleware_home>/-',
permClass='java.security.AllPermission', permTarget=None,
permActions=None)

Example:

grantPermission(appStripe=None, principalClass=None, principalName=None,
codeBaseURL='file:/scratch/app/product/fmw/-', permClass='java.security.AllPermission',
permTarget=None, permActions=None)

2. Start the admin server.

$cd <MIDDLEWARE_HOME >/user_projects/domains/domain_name/bin
$./startWeblogic.sh

3. Start themanaged server "bam_server1".

$cd <MIDDLEWARE_HOME>/user_projects/domains/domain_name/bin
$./startManagedWebLogic.sh <managed server name>
t3://localhost:<admin server port>

Post Installation Configuration

Execute obp-soa-post-install.sh as done for SOA Media Pack Installation.

1. Navigate to themiddleware location and give executable permission to the post install script.

$cd <middleware home>

2. Run the script by:

$./obp-soa-post-install.sh

3. Finally after obp-soa-post-install.sh script is run, restart the bammanaged server "bam_server1".

$cd <MIDDLEWARE_HOME>/user_projects/domains/domain_name/bin
$./startManagedWebLogic.sh <managed server name>
t3://localhost:<admin server port>

4. Log in to BAM Composer http: //$IP:PORT/bam/composer/faces/login.
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8.2 Post Installation Configuration

Figure 8–34 BAM Composer page
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8.2 Post Installation Configuration

Figure 8–35 BAM Composer page (contd)
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8.2 Post Installation Configuration

Figure 8–36 BAM Composer page
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9 Standalone Database Setup

This chapter details the steps involved in Oracle Banking Platform Database which are primarily concerned
with importing an existing database dump of the QA database.

Note

In case the Oracle Banking Platform database is manually created and
seeded, then you need to skip this during installobp.sh by clicking
Cancel which causes the script to skip this step and proceed with the
rest of the installation workflow.

9.1 Pre-Installation Steps
The following steps should be completed prior to the process of executing the installation steps for the Oracle
Banking Platform DB mentioned in Section 9.2 Oracle Banking Platform Database Setup – RCU Installation:

1. Oracle Database Enterprise Edition 12.1.0.2.0 must be installed on the database server.

2. Obtain the tar file dbscripts.tar.gz from OBP Host media pack (dbscripts.tar.gz is present in host.zip)
and copy it onto the database server.

3. Ensure that the ONS service is started after DB installation where the OBP Application schema needs
to be created.

9.2 Oracle Banking Platform Database Setup – RCU
Installation
The steps that should be performed to create the OBP Host DB schema are provided in Section 9.3 Host DB
SchemaCreation and Verification

For other RCU schemas , while installing software on HOST, UI, and SOA, specific RCU should execute to
create schemas for SOA, UI, and HOST.

RCU utility is present under <MW_HOME/oracle_common/bin> for respective components.

Following is the list of schemas to be created for SOA, UI, and HOST, respectively (please note, SOA,UI and
HOST are the prefix in below schemas which is given during schema creation).

n SOA_SOAINFRA

n SOA_MDS

n SOA_STB

n SOA_UMS

n SOA_OPSS

n SOA_IAU_APPEND

n SOA_IAU_VIEWER
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9.2 Oracle Banking Platform Database Setup – RCU Installation

n UI_STB

n UI_OPSS

n UI_MDS

n UI_IAU_APPEND

n UI_IAU_VIEWER

n HOST_STB

n HOST_OPSS

n HOST_IAU_APPEND

n HOST_IAU_VIEWER

n HOST_MDS

UI_MDS and UI_STB schemas are used by UI component.

HOST_MDS and HOST_STB schemas are used by HOST component.

SOA_SOAINFRA, SOA_STB, SOA_MDS and SOA_UMS schemas are used by SOA component.

UI_OPSS and HOST_OPSS schemas are used for silent domain creation in pre installation by UI and HOST
respectively.

SOA_OPSS, SOA_IAU_APPEND and SOA_IAU_VIEWER schemas are shared by HOST and UI also
pointed during post installation of HOST and UI.

Increase the size of tablespace (at least 6GB and should be in auto extendmode on) for SOA_MDS,
SOAINFRA andOPSS schema used for SOA domain creation.
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9.3 Host DB Schema Creation and Verification

Figure 9–1 Host DB Schema Setup Confirmation

9.3 Host DB Schema Creation and Verification
For the host db schema creation, copy the dbscripts.tar.gz file from OBP Host media pack (dbscripts.tar.gz is
present in host.zip) location to any machine where 'sqlplus' is available.

Untar dbscripts.tar.gz file which contains createobp.sql, ddl and seed file and folders.(TNS entry of the host
dbmay be required in that machine to enable connectivity from themachine to the host db server.)

In createobp.sql, Replace &&1,&&2 and &&3with schema, password, and tablespace name.

Before executing createobp.sql, make sure tablespace is created in the database.

The createobp.sql will create application schemawith required database grants.

createobp.sql execution

PROMPT> sqlplus sys/password@TNSEntryOfDB as sysdba @createobp.sql

9.4 HOST DB schema ddl execution
Now open command prompt and navigate inside “ddl” folder in themachine where it has been copied. Then
run the following using the actual details of host db schemawhile was created.

Connect to application schema (which is created using createobp.sql) using sqlplus
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9.5 HOST DB Schema Seeding

PROMPT> sqlplus schemauser/password@TNSEntryOfDB @ddl/SCHEMA_
DDL.sql

The example assumes that the seed is being executed from “D:\ORACLE” folder of aWindows machine
having sqlplus console available for execution of sql commands and scripts.

C:> D:
C:> cd D:\ORACLE
D:\ > sqlplus DEV_OBP/welcome1@OBPDB
D:\ >@ddl/SCHEMA_DDL.sql

The following verification steps can be executed to check that the Database setup is complete:

1. Verify that the new tablespace is created.

2. Logon to the database with user id created.

3. Execute the query “select * from tab;” on the sql prompt to verify that the OBP tables are present.

9.5 HOST DB Schema Seeding
This section provides information on the Host Database Schema Seeding. The procedure is as follows:

Now open command prompt and navigate inside the ’seed’ folder in themachine where it has been copied.
Run the following commands using the actual details of host db schemawhich was created.

PROMPT> sqlplus schemauser/password@TNSEntryOfDB @seed.sql
For example, assume that the seed is being executed from ’D:\seed’ folder of aWindows machine having
sqlplus console available for execution of sql commands and scripts.

C:> D:
C:> cd D:\seed
D:\seed > sqlplus DEV_OBP/welcome1@OBPDB
D:\seed >@seed.sql

It will take some time to completely execute all the seed scripts. It will ask for some inputs at the time of
seeding, just press Enter to continue. WhenOBP DB seeding is completed, the control will return to the sql
prompt.

Note

If you are going to install localization on top of product, DONOT
execute ddl and seed of product, execute ddl and seed which are
present under localization host mediapack in form of dbscripts_
au.tar.gz and dbScripts_us.tar.gz.

9.6 System Configuration DB Update Script Execution
After the host db schema has been created successfully, copy the ’updateSystemDetails.sql’ file from
’HOST_MW_HOME’ location to any machine where 'sqlplus' is available. (TNS entry of the host dbmay be
required in that machine to enable connectivity from themachine to the host db server).

Now, open command prompt and navigate ’updateSystemDetails.sql’ file in the local machine where it has
been copied. Then run the following using the actual details of host db schemawhich was created.

PROMPT> sqlplus schemauser/password@TNSEntryOfDB @
updateSystemDetails.sql
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9.7 Database Table Partitioning

For example, assume that the seed is being executed from ’D:\script’ folder of aWindows machine having
sqlplus console available for execution of sql commands and scripts.

C:> D:
C:> cd D:\script
D:\seed > sqlplus DEV_OBP@welcome1@OBPDBB
D:\seed >@updateSystemDetails.sql

9.7 Database Table Partitioning
For Database Table Partitioning, execute the scripts present in Table_Partitioning.zip present in host.zip.
Execute the script in sequence and follow the guidelines mentioned in the script.

1. OBP_PARTITION_TABLE.sql

2. OBP_PARTITION_TABLE_SEED.sql

3. APPLY_PARTITION.sql
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10 Oracle Banking Platform and IPM
Integration

This chapter details the steps involved in the integration of Oracle Banking Platform andOracle Imaging and
Process Management (IPM).

OBP integrates natively with Oracle IPM as the content management solution. Configuration information
relevant from anOBP point of view is provided in the following sections:

n Section 10.1 IPM Application Setup for OBP Content Management

n Section 10.2 IPM Configuration for Bulk Upload Process Setup

n Section 10.3 IPM Report Upload Setup

The steps listed therein should be followed to configure IPM to facilitate it to integrate with OBP. However,
you can see the administration guide for Oracle IPM for details on how tomanage connections, inputs and
applications in IPM.

10.1 IPM Application Setup for OBP Content Management
This is amandatory configuration required on IPM to enable integration of OBP with IPM for content
management.

The following properties from the checklist should be used for creating connection profiles in theManage
Connections section. These connection profiles will be used while creating the applications on the next
section onManage Applications.

10.1.1 UCM Connection
The UCM connection is used to point to the underlying UCM Server where the documents are stored.

1. Log in to IPM imaging console through a URL such as follows:

http:// hostname:16000/imaging
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Figure 10–1 IPM Imaging Console - Login page

2. Enter the username and password set during IPM installation.
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Figure 10–2 IPM - Welcome page

3. Navigate toManage Connection --> Create Content Server Connection.
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Figure 10–3 Create Content Server Connection

4. Enter the name and description of UCMConnection.
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Figure 10–4 UCM: Basic information

5. Provide the connection settings for the content server.
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Figure 10–5 UCM: Connection Settings

6. Configure the security rights for the connection as shown below.

185 | Oracle Banking Platform Installation Guide - Silent Installation



10.1 IPM Application Setup for OBP Content Management

Figure 10–6 UCM: Connection Security

7. Review the settings and click Submit.
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Figure 10–7 UCM: Review Settings

10.1.2 Main Application Configuration
The documentation for Oracle IPM should be referred to for details on how to create applications in IPM. For
more information, see https://docs.oracle.com/cd/E14571_01/admin.1111/e12782/c04_
applications.htm#IPMAD159.

Create amain application and a temporary application in IPM.

10.1.2.1 Manage Application Configuration
Tomanage application configuration:

1. Select Create New Application option.

2. Enter the general properties and click Next.
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Figure 10–8 Main: General Properties

3. Enter the field definition details and click Next.
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Figure 10–9 Main: Field Definitions
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Figure 10–10 Field Definitions (cont.)

4. In Application Security and Document Security pages, select the access rights for users and click
Next.
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Figure 10–11 Main: Application Security
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Figure 10–12 Main: Document Security

5. In the Storage Policy page, select the file default option as shown below.
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Figure 10–13 Main: Storage Policy

6. Click Next. Skip theWorkflow Configuration page.

7. Click Next.
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8. Review the summary and click Submit.

Figure 10–14 Main: Review Settings

10.1.2.2 Manage Searches
Tomanage searches:
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1. Click Manage Searches option and enter the search namewith description.

Figure 10–15 Main: Properties

2. Click Next.

3. Select the source application along with its field details in the Results Formatting page.
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Figure 10–16 Main: Results Formatting

4. Select the appropriate conditions in the Conditions page as shown below.
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Figure 10–17 Main: Conditions

5. Select the appropriate settings in the Parameters page as shown below.
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Figure 10–18 Main: Parameters

6. Configure the access rights for users for search in the Search Security page.
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Figure 10–19 Main: Search Security

7. Review the summary and click Submit.
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Figure 10–20 Main: Preview and Test
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Figure 10–21 Main: Review Settings

10.1.3 Temp Application Configuration
This section provides details about the temp application configuration.

10.1.3.1 Manage Application Configuration
Tomanage application configuration:

1. Select the Create New Application option.

2. Enter the general properties and click Next.
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Figure 10–22 Temporary: General Properties

3. Enter the field definition details and click Next.
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Figure 10–23 Temporary: Field Definitions

4. In Application Security and Document Security pages, select the access rights for users and click
Next.
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Figure 10–24 Temporary: Application Security
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Figure 10–25 Temporary: Document Security

5. In the Storage Policy page, select the file default option has shown below.
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Figure 10–26 Temporary: Storage Policy

6. Click Next. Skip theWorkflow Configuration page.

7. Click Next.

8. Review the summary and click Submit.
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Figure 10–27 Temporary: Review Settings

10.1.3.2 Manage Searches
Tomanage searches:
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1. Click theManage Searches option and enter the search namewith description.

Figure 10–28 Temporary: Properties

2. Select the source application along with its field details in the Results Formatting page.
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Figure 10–29 Temporary: Results Formatting

3. Select the appropriate conditions in the Conditions page as shown below.
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Figure 10–30 Temporary: Conditions

4. Select the appropriate settings in the Parameters page as shown below.
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Figure 10–31 Temporary: Parameters

5. Configure the access rights for users for search in the Search Security page.
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Figure 10–32 Temporary: Search Security

6. Review the summary and click Submit.
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Figure 10–33 Temporary: Preview and Test
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Figure 10–34 Temporary: Review Settings

The application ID generated for themain and temporary applications should be updated in the OBP DB
schema table flx_cm_doc_typ_meta_data using the following sql statements:

Note

Replace the <main application id> with the application ID generated for
the IPM application and the <temporary application id> with the
application ID generated for the IPM application sql statements with
the actual generated.

SQL for Main Application

update flx_cm_doc_typ_meta_data
set app_id = '<main application id>'
where doc_typ_id = 'MAIN';

SQL for Temp Application

update flx_cm_doc_typ_meta_data tp
set app_id = '<temporary application id>'
where doc_typ_id = 'TEMP';
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10.2 IPM Configuration for Bulk Upload Process Setup
This step is an optional configuration step. It is required only for banks that need to upload documents in bulk.
Creation of an input configuration results in defining an input file format andmapping the file input data with the
application field definitions. This file format is then understood by the IPM Bulk data upload feature (known as
an document upload input agent in IPM), which uploads scanned documents from a shared folder on into IPM.

This upload takes place in the following steps:

A file containing details of the scanned documents to be uploaded is taken as an input from a location on the
server. Then IPM uploads the scanned documents as specified in an input definition file.

Then IPM invokes the "IPMBulkUpload" BPEL process deployed on the SOA server as part of the SOA
media pack installation process. The BPEL process updates the IPM document reference ID in OBP for the
document record.

10.2.1 Prerequisites
Following are the prerequisites before proceeding with the bulk upload process setup:

1. Application on IPM server is already created on which bulk upload process needs to be configured. For
more information to understand the application creation process, see Image Processing and
Management Admin Guide.

2. com.ofss.fc.workflow.process.IPMBulkUploadProcess is already deployed on the SOA server.

10.2.2 Setting up the Connection Name
To set up a bulk process we need to start by setting up the connection name, which is used as JNDI for IPM
to BPEL connection.

To set up a bulk process:
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1. Log in to EnterpriseManager (EM) console.

Figure 10–35 EM Console Login

2. In the Name section, underWeblogic domain, click ipm domain (or base domain where ipm server is
installed).
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Figure 10–36 Click Weblogic Domain: ipm domain

3. In the topmenu, click Weblogic Domain. The correspondingmenu appears.

4. Navigate to Security > Credentials. The Credentials page appears.
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Figure 10–37 Navigate to Weblogic Domain --> Security --> Credentials

5. Click Create Map to create amapwith theMap Name as oracle.wsm.security.
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Figure 10–38 Create Map oracle.wsm.security

6. Click Create Key to create a key under themap oracle.wsm.security..
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Figure 10–39 Create Key basic.credentials

7. In the Key field enter the key name as basic.credentials.

8. In the Type field, select the value as Password.

9. Enter the other required details.
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10. Click Ok. The key is saved.

Figure 10–40 ipm_domain: Credentials Created

10.2.3 Setting up Input Agent Path
To set up input agent path:

1. Log in to EnterpriseManager (EM) console.

2. In the Name section, underWeblogic domain, click ipm domain.

3. In the topmenu, click Weblogic Domain. The correspondingmenu appears.

4. Navigate to the domain SystemMBean Browser. The SystemMBean Browser page appears.
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Figure 10–41 Navigate to Weblogic Domain --> System MBean Browser

5. In the left hand pane, navigate toApplication Defined MBeans > oracle.imaging > Server: IPM_
server1 > config.

6. For the attribute InputDirectories, in theValue column enter the value to set the path for input agents.
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Figure 10–42 InputDirectories: Enter Input Agent Path

7. Restart IPM server.

10.2.4 Create SOA Connection
To create a SOA Connection:

1. Log in to Image ProcessingManagement (IPM).

2. Navigate to theManage Connections section.
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Figure 10–43 Manage Connections: Create Workflow Connection

3. Click Create Workflow Connection.

Workflow Connection is used to point to the "IPMBulkUpload" BPEL process deployed on the SOA
server as part of the SOA media pack installation process.

OBP_IPM_SOA_CONN_NAME

SOA_MANAGED_SERVER_LISTEN_ADDRESS

SOA_MANAGED_SERVER_LISTEN_PORT

4. In theName field, enter the name for SOA Connection as IUTSOA.
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Figure 10–44 IUTSOA: Basic Information

5. In theHTTP Front End Address field, enter the value for SOA server.
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Figure 10–45 IUTSOA: Workflow Settings

6. In theCredential Alias field, enter the value as basic.credentials.

7. Click Next to proceed. The Connection Security page appears.
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Figure 10–46 IUTSOA: Connection Security

8. Provide the requisite security rights to the connection's definition.

9. Click Submit.

10. Click Next. The Review Settings page appears.
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Figure 10–47 IUTSOA: Review Settings

10.2.5 Manage Workflow Configuration
Tomanage workflow configuration:

1. Log in to Image ProcessingManagement (IPM).

2. Navigate toManage Applications section.
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Figure 10–48 Main: Application Summary

3. Select the application for which workflow configuration has to be done as shown in Figure 10–48.

4. Click Modify.

5. Navigate to theWorkflow Configuration section.

6. Click theAdd/Modify button.

7. In the Server Properties section, select the connection (IUTSOA) which was created inManage
Connections section from the Connection list.

229 | Oracle Banking Platform Installation Guide - Silent Installation



10.2 IPM Configuration for Bulk Upload Process Setup

Figure 10–49 Manage Applications - Server Properties

8. Click Next.

9. In the Component Properties section, select the Composite, Service andOperation values.

10. From the Composite list, select default/com.ofss.fc.workflow.process.IPMBulkUploadProcess!1.0
from the list of process.

11. From the Service list, select ipmbulkuploadbpelprocess_client_ep.

12. From theOperation list, select process.
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Figure 10–50 Manage Applications - Component Properties

13. Click Next.

14. In the Payload Properties section, map the payload elements with mapped value as shown in following
figure.

15. Map the process fields with application field definitions.

Note

The document ReferenceId is mapped to Document Id (IPM internal
field), whereas documentId is mapped to doc Id which is application
field.
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Figure 10–51 Manage Applications - Payload Properties

16. Click Next.

17. Complete theWorkflow Configuration. Click Next.
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Figure 10–52 Manage Applications - Workflow Configuration

18. Add all those fields which are not present in the application as shown below.
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Figure 10–53 Field Definitions

TheMain Application Summary appears as shown Figure 10–54.
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Figure 10–54 Main: Application Summary

10.2.6 Manage Inputs for Input Agents
Tomanage workflow configuration:

1. Log in to Image ProcessingManagement (IPM).

2. Navigate toManage Inputs section.
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Figure 10–55 Input Agent: Basic Information

3. Define an input agent by entering a Name. For example, bulkUploadInput.

4. Define Input Mask as DMSInputSampleFile.txt.
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Figure 10–56 Input Agent: Input Mask

5. Upload the attached sample file.

For example, name the sample file as DMSInputSampleFile.txt and add the following content to the
sample file.

/home/oracle/IPM_Bulk_Upload/IMPCommands.txt|IN_
INCERT|1234|PARTY:1234|ME01|BU01|

6. In the Input Mask field enter the value which should be the same as the name given in table flx_fw_
config_all_b.

select prop_value from flx_fw_config_all_b where category_id = 'reports' and prop_id='BULK_
UPLOAD_FILE_NAME_PREFIX';

Note

Input Mask name should have a * (asterisk character) to enable the
process to read all the files whose prefix is same as the input mask
value.

7. In theDelimeter field, enter the delimiter value as | (vertical bar character).
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8. From theApplication field, select the application to which the input agent will be applied.

Figure 10–57 Input Agent: File Parameters

9. In the Field Mapping section, map theApplication Fields.
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Figure 10–58 Input Agent: Fields Mapping

10. After completion of the procedure, the Input Summary appears. The Input agent should have the
settings similar to those shown in Figure 10–59.
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Figure 10–59 Input Agent: Summary

Note

Do not forget to toggle online, else the input agent will not pick up any
file for processing.

10.2.7 Additional Steps
1. Update user and bankcode as follows:

update flx_fw_config_all_b set prop_value='48' where prop_
value='335' and category_id like 'contentmanager%';
update flx_fw_config_all_b set prop_value='ofssuser' where
prop_id='userId' and category_id like 'contentmanager%';

2. In the flx_fw_config_all_b table, the values forPROP_ID should be the same as mentioned for the path
in IPM server.
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PROP_ID PROP_VALUE

FTPSERVER.DMSFILEPATH=/scratch/ofssobp/testinputagent/inputdir1/ Path in IPM config

FTPSERVER.REPORTPATH=/scratch/reports/ Path where files will
be FTP

FTPSERVER.HOST IPM IP

BULK_UPLOAD_FILE_NAME_PREFIX
Input Mask name
given in 1.5Manage
Inputs for Input
Agents section.

Table 10–1 PROP ID Values

Figure 10–60 flx_fw_config_all_b table

3. FTP service on IPM server should be running and FTP user should be created on host user connectors.

10.2.8 SSL Handshake Resolution
For resolving the SSLHandshake between IPM and SOA server:
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1. Save the SOA server Certificate. SOA certificate needs to be saved in Base64 (.cer) format for import
to IPM server.

2. Import the SOA server certificate on IPM server with following command.

Copy certificate at following path on IPM server.

keytool -import -noprompt -trustcacerts -alias UI_SSL_trustself -file SOACert.cer -keystore cacerts -
storepass changeit

3. Security policy for IPMbulkuploadProcess can been removed (if required).

Security for calledmethod

com.ofss.fc.app.content.service.DocumentContentApplicationService.documentUpload
(SessionContext, DocumentDTO) needs to be removed (for Development environment).

Figure 10–61 SSL Handshake Resolution

10.3 IPM Report Upload Setup
This section describes the configuration on IPM server, which is required for bulk report upload on IPM.

10.3.1 Prerequisites
Following are the prerequisites before proceeding with bulk upload process setup:
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1. Application on IPM server on which bulk upload process needs to be configuredmust be created. For
more information to understand the application creation process, see Image Processing and
Management Admin Guide.

2. com.ofss.fc.workflow.process.ReportIPMRefStoreProcess must be deployed on SOA server.

10.3.2 Setting up the Connection Name
To set up a bulk process we need to start by setting up the connection name, which is used as JNDI for IPM
to BPEL connection.

To set up a bulk process:

1. Log in to EnterpriseManager (EM) console.

Figure 10–62 Log in to Enterprise Manager (EM) console

2. In the FusionMiddleware section, underWeblogic domain, click ipm domain (or base domain where
ipm server is installed).

243 | Oracle Banking Platform Installation Guide - Silent Installation



10.3 IPM Report Upload Setup

Figure 10–63 Click Weblogic Domain: ipm domain

3. In the topmenu, clickWeblogic Domain. The correspondingmenu appears.

4. Navigate toSecurity > Credentials. The Credentials page appears.
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Figure 10–64 Navigate to Weblogic Domain --> Security --> Credentials

5. Click Create Map to create amapwith theMap Name as oracle.wsm.security.
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Figure 10–65 Create Map oracle.wsm.security

6. Click Create Key to create a key under themap oracle.wsm.security.
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Figure 10–66 Create Key: basic.credentials

7. In theKey field, enter the key name as basic.credentials.

8. In the Type field, select the value as Password.

9. Enter the other required details.

10. Click Ok. The key is saved.
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Figure 10–67 ipm_domain: Credentials Created

10.3.3 Setting up Input Agent Path
To set up input agent path:

1. Log in to EnterpriseManager (EM) console.

2. In the FusionMiddleware section, underWeblogic domain, click ipm domain.

3. In the topmenu, click Weblogic Domain. The correspondingmenu appears.

4. Navigate to the domain SystemMBean Browser. The SystemMBean Browser page appears.
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Figure 10–68 Navigate to Weblogic Domain --> System MBean Browser

5. In the left hand pane, navigate toApplication Defined MBeans > oracle.imaging > Server: IPM_
server1 > config.

6. For the attribute InputDirectories, in theValue column enter the value to set the path for input agents.

7. Change the highlighted path value to /scratch/ofssobp/testinputagent/inputdir1.
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Figure 10–69 InputDirectories: Enter Input Agent Path

8. Restart IPM server.

10.3.4 Create SOA Connection
To create a SOA Connection:

1. Log in to Image ProcessingManagement (IPM).

2. Navigate to theManage Connections section.
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Figure 10–70 Manage Connections: Create Workflow Connection

3. Click Create Workflow Connection.

4. In theName field, enter the name for SOA Connection as IUTSOA.
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Figure 10–71 IUTSOA: Basic Information

5. In theHTTP Front End Address field, enter the value for SOA server.
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Figure 10–72 IUTSOA: Workflow Settings

6. In theCredential Alias field, enter the value as basic.credentials.

7. Click Next to proceed. The Connection Security page appears.
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Figure 10–73 IUTSOA: Connection Security

8. Provide the requisite security rights to the connection's definition.

9. Click Submit.

10. Click Next. The Review Settings page appears.
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Figure 10–74 IUTSOA: Review Settings

10.3.5 Manage Application Configuration
1. Navigate to theManage Applications section.

2. Select Create New Application option. The Create Application: General Properties page appears.
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Figure 10–75 Create Application: General Properties

3. Enter the general properties for the application and click Next. The Report: Field Definitions page
appears.

10 Oracle Banking Platform and IPM Integration | 256



10.3 IPM Report Upload Setup

Figure 10–76 Report: Field Definitions

4. Enter the field definition details and click Next. The Create Application: Applications Security page
appears.
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Figure 10–77 Create Application: Applications Security

5. In the Application Security section, select the access rights for users and click Next. The Create
Application: Document Security page appears.
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Figure 10–78 Create Application: Document Security

6. In the Document Security section, select the access rights for users and click Next. The Create
Application: Storage Policy page appears.
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Figure 10–79 Create Application: Storage Policy

7. In Storage Policy section, select the File Default option in the Document Storage and Supporting
Content Storage fields.

8. Click Next. The Report: Workflow Configuration page appears.

9. Enter theWorkflow Configuration details in the Server Properties, Component Properties and Payload
Properties sections as shown.
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Figure 10–80 Report: Workflow Configuration - Server Properties
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Figure 10–81 Report: Workflow Configuration - Component Properties
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Figure 10–82 Report: Application Summary

10. Review the summary and click Submit.
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Figure 10–83 Create Application: Review Settings

10.3.6 Manage Inputs for Input Agents
Tomanage workflow configuration:

1. Log in to Image ProcessingManagement (IPM).

2. Navigate toManage Inputs section.
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Figure 10–84 Manage Inputs

3. Define an input agent by entering a Name. For example, bulkUploadInput.

4. Define Input Mask as ReportRepositoryControlFileLZN*.txt.
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Figure 10–85 Input Agent Details: Input Mask

5. Upload the sample file.

For example, name the sample file as ReportRepositoryControlFile.txt and add the following content to
the sample file.

/home/oracle/reports/CH318153449.869.txt|10|BRN|0|0|GLBL_BU_
PB|1000|OFSSUser|2016031008493939|TD101|BOD|BRN_GRP_
1|20160131000000|2.IPM_314505|1010|

6. In the Input Mask field, enter the value which should be the same as the name given in table.

flx_fw_config_all_b

select prop_value from flx_fw_config_all_b where category_id = reports and prop_id=REPORT_
UPLOAD_FILE_NAME_PREFIX;

appended with name given in table flx_fw_config_var_b

select prop_value from flx_fw_config_var_b where prop_id = env.name;
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Note

Input Mask name should have a * (asterisk character) to enable the
process to read all the files whose prefix is same as the input mask
value.

7. In theDelimeter field, enter the delimiter value as | (vertical bar character).

8. From theApplication field, select the application to which the input agent will be applied.

Figure 10–86 Input Agent Details: Field Mapping

9. Select the access rights for user in the Security section and click Next.
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Figure 10–87 Input Agent Details: Security

The Input Summary appears. The Input agent must have the settings similar to those shown in the
following figure.
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Figure 10–88 Input Agent Details: Review Settings

Note

Do not forget to toggle online, else the input agent will not pick up any
file for processing.

10.3.7 Manage Searches
Tomanage searches:
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1. Click Manage Searches option and enter the search namewith description.

Figure 10–89 Create Search: Properties

2. Select the source application along with its field details.
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Figure 10–90 Create Search: Results Formatting
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Figure 10–91 Create Search: Conditions
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Figure 10–92 Create Search: Parameters

3. Select the access rights for users in security configuration.
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Figure 10–93 Create Search: Security

4. Review the summary and click Submit.
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Figure 10–94 Create Search: Preview and Test
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Figure 10–95 Create Search: Review Settings

10.3.8 Additional Steps
1. Update user and bankcode as follows:

update flx_fw_config_all_b set prop_value= ofssuser where prop_id='userId' and category_id like
contentmanager%;

2. In the flx_fw_config_all_b table, the values for PROP_ID should be the same as mentioned for path in
IPM server.

PROP_ID PROP_VALUE

FTPSERVER.DMSFILEPATH=/scratch/ofssobp/testinputagent/inputdir1/ Path in IPM config

FTPSERVER.REPORTPATH=/scratch/reports/ Path where files will
be FTP

FTPSERVER.HOST IPM IP

BULK_UPLOAD_FILE_NAME_PREFIX Input Mask name

Table 10–2 PROP ID Values
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PROP_ID PROP_VALUE

given in 1.5Manage
Inputs for Input
Agents section.

3. FTP service on IPM server should be running and FTP user should be created on host user connectors.

4. For resolving the SSLHandshake between IPM and SOA server:

a. Save the SOA Server Certificate. SOA certificate needs to be saved in Base64 (.cer) format for
import to IPM server.

b. Import the SOA server certificate on IPM server with following command.

Copy certificate at the following path on IPM server.

path:/scratch/app/product/oracle_jrockit_jdk1.6.0_37_R28.2.5_4.1.0/jre/lib/security

keytool -import -noprompt -trustcacerts -alias UI_SSL_trustself -file SOACert.cer -keystore
cacerts -storepass changeit

c. Security policy for ReportIPMRefStoreProcess can been removed (if required).

Security for calledmethod

com.ofss.fc.app.report.ReportGenerationApplicationService.updateAdhocReportContentRefId
(SessionContext, ReportRequestDTO) needs to be removed (for Development environment).

com.ofss.fc.app.report.ReportGenerationApplicationService.updateBatchReportContentRefId
(SessionContext, BatchRequestDTO) needs to be removed (for Development environment).
com.ofss.fc.app.report.ReportGenerationApplicationService.updateSplitReportContentRefId
(SessionContext, ReportSplitDetailDTO) needs to be removed (for Development environment).
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Figure 10–96 Component Properties
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This chapter explains the steps required for integration of Oracle Banking Platform with OCH andOSC.

11.1 OCH Server Configuration in OBP
OBP integrates with Oracle Customer Hub as the customermaster datamanagement solution. Configuration
information relevant from anOBP point of view is provided below.

OBP integrates with OCH using the synchronous integration pattern using the OCH services. These service
WSDLs are present as part of seed data. For the integration to work, IP address and port of OCH server need
to be configured in OBP.

Following are the steps to configure OCH so that it can integrate with OBP:

1. Log on to the admin URL of OBP using the username and password set in OID.

https://<hostserver>:<port>/com.ofss.fc.ui.view.admin/login.html

Figure 11–1 OBP Admin Login

2. Navigate to Configurations -> Configuration Variables Information (Fast Path: CFG01).
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Figure 11–2 Navigate to Configurations

Figure 11–3 Configuration Variables Information (Fast Path: CFG01)

3. Click Fetch Records.

4. Search the text: och.*
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Figure 11–4 Search och.*

5. Update the server IP and port values. Click Ok.

Figure 11–5 Update Server IP and Port Values

11.2 OCH Customizations for OBP Integration
Certain customizations are required in Oracle Customer Hub for integration with OBP. The Post Installation
steps for configuring them are explained the sections below.

11.2.1 Webservices
The following steps activate the workflows, following which authentication is set for all the InboundWeb
Services:
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1. Navigate to Application > Site Map.

2. Navigate to Administration - Business Process page.

Figure 11–6 Administration - Business Process

3. Navigate toWorkflow Deployment View > Repository Workflow Process.

4. Query (Alt+Q) for the following workflows:

n UCM Financial Asset Customer Profile Integration SOAP Process

n UCM Financial Asset Customer Profile Integration SOAP Query Process

n UCMOrganization Customer Profile Integration SOAP Process

n UCMOrganization Customer Profile Integration SOAP Query Process

n UCM Person Customer Profile Integration SOAP Process
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n UCM Person Customer Profile Integration SOAP Query Process

n UCM Privacy Process

5. Click Activate to activate all the workflows (queried in the earlier step) by selecting the record.

Figure 11–7 Repository Workflow Process

6. Navigate to AdministrationWeb Services > InboundWeb Services.
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Figure 11–8 InboundWeb Services

7. Set the Authentication for all the Services listed in step 9.

8. Query for the following:

n PersonService

n PersonCrossReferenceService

n PersonMatchService

n OrganizationService

n OrganizationMatchService

n OrganizationCrossReferenceService

n FinancialAssetService

n FinancialAssetCrossReferenceService

9. For each InboundWeb Service queried inthe earlier step, in the Operations section and set the
authentication toUsername/Password - clear text.
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Figure 11–9 Operations - Set Authentication

10. Click Clear Cache.

11.2.2 System Registration
To register a new system:

1. Navigate to the Administration - Universal CustomerMaster > System Registrations view.

2. In the System Registrations view, click New.

3. Enter the appropriate information in the available fields to define the system.
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Figure 11–10 System Registration

11.2.3 Set System Privileges
To set a system's privileges:

1. Navigate to the Administration - Universal CustomerMaster > System Registrations view.

2. From the Systems Registrations list, select the system of interest, and click the link in theSystem ID
field.

3. From the System Detail view, click the System Privileges tab.

4. In the System Privileges view, click New.
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Figure 11–11 System Detail

11.2.4 Seed LOV Addition
This section explains the procedure to add seed data to LOV.

1. Navigate to Administrative - Data > List of Values.

2. Query for the LOV Type.

3. Create a new record.

n OBP's Codemaps to -> Language-Independent Code (LIC) of OCH

n OBP's Display Valuemaps to -> Display Value of OCH

4. Add the following:

Type (eg. CONTACT_TYPE)

Display Value (eg: Individual)

Language Independent Code (eg: IND)

Language Name :¿ English-American¿

Order (put a numeric value* )

Active (It¿s a checkbox. So, mark it as active)

*Order is anOptional field. But some picklist may have search spec onOrder.

Eg : [Order By]<3

It is recommended to put the value of order as the next number in the sequence or refer the picklist
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definition for the valid range of order for that LOV Type in Picklist Definition in Siebel Tools.

5. After all the values get added, click Clear Cache.

11.3 OBP related Customizations Required in OCH
This section provides details about OBP related customizations required in OCH.

11.3.1 Account Type field addition in LS Product Form Applet More Info
Applet
Following are the steps to set the field Account Type of FINCORP Account through UI:

1. Launch the Siebel Tool.

2. In the Object Explorer, select the object Applet.

3. Query for the applet LS Product Form Applet More Info. Note that this is same applet where the
customer is suggested to set the field Category for their usage.

4. Select the applet record, right-click and select Lock Object.

5. Expand the Applet tree in the object explorer and select Applet Web Template.

6. Select the record with name Edit in the list of displayed records at second level.

7. Right-click and select Edit Web Layout. The applet's form layout is displayed.

8. From the Controls/Columns pane, identify the controls with the name FINS Product Type. There
should be two records with names as FINS Product Type, and FINS Product Type Label. One refers to
control and the other refers to Caption.

9. Drag the two controls on to the applet at any desired space of customer's choice. Note that the
controls should not overlap each other.

10. Close the web layout by clicking the X mark on the window. The system prompts to save the changes.

11. Select Yes. The web layout closes and displays the applet details again.

12. Re-query the applet and compile the changes on to the SRF.

13. Bring down the services in the server, and replace the SRF.

14. Restart the services and test.

11.4 Changing the LOV from COUNTRY to COUNTRY_CODE
for UCM Country of Incorporation
This section provides information on changing the picklist for UCMCountry of Incorporation field in Account
BC.

n Account BC

n Pick List Country NXG

To change the picklist:

1. Launch Siebel Tools.

2. In the Object Explorer, select the object Project.
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3. Right-click the record pane and select New Record to create new project if NXG is not present
already.

4. Provide the name as NXG and set the property Locked to True.

5. Save the record by stepping off the record or Ctrl + S.

6. In Object Explorer, click the object pick list. It should display some list of available record.

7. Right-click the record pane and select New Record. An empty record is created in the record pane.

8. Enter the new record details as follows:

Entity Value Comments

Name PickList Country NXG Any name of customer’s choice

Project NXG
Any project of customer’s choice. Preferably,
the same project name, which is used for
custom repository can be provided.

Bounded TRUE Should be checked

Static TRUE Should be checked

Business
Component List Of Values Should bementioned as is

No Delete, No
Insert, NoMerge,
No Update

TRUE Should be checked

Type Field Type Should bementioned as is

Type Value COUNTRY_CODE Should bementioned as is

Table 11–1 New Record Details

9. Save the record by stepping off the record or Ctrl + S.

10. Query the business component in which the customer wants this picklist to be used. The BC name is
Account.

11. Expand this BC in the object explorer and click its field entity.

12. Query for the field UCMCountry of Incorporation.

13. Select UCMCountry of Incorporation field and perform the following changes in it.

Property Name Value Comments

Picklist PickList Country NXG The new picklist which is created.

Table 11–2 Picklist Country NXG

11.5 Setting Hierarchical Picklist for Country and State
The Hierarchical Picklist changes are as follows:

n Personal Address BC

n CUT Address BC

11 OBP and OCH-OSC Integration | 290



11.5 Setting Hierarchical Picklist for Country and State

n Pick List Country Code NXG

n Picklist State NXG

The detailed steps of configuring Hierarchical Picklists are as follows:

1. Launch Siebel Tools.

2. In the Object Explorer, select the object Project.

3. Right-click the record pane and select New Record to create new project if NXG is not present
already.

4. Provide the name as NXG and set the property Locked to True.

5. Save the record by stepping off the record or Ctrl + S.

6. In Object Explorer, click the object pick list. It should display a list of available records.

7. Right-click the record pane and select New Record. An empty record is created in the record pane.

8. Provide the new record details as follows:

Value Comments

Name PickList Country NXG Any name of customer choice

Project NXG
Any project of customer’s choice.
Preferably, the same project name, which is
used for custom repository can be provided.

Bounded TRUE Should be checked

Business Component PickList Hierarchical Should bementioned as is

No Delete, No Insert,
NoMerge, No Update TRUE Should be checked

Type Field Type Should bementioned as is

Type Value COUNTRY_CODE Should bementioned as is

Table 11–3 New Record Details

9. Save the record by stepping off the record or Ctrl + S.

10. Right-click the record pane and select New Record again. An empty record is created in the record
pane.

11. Provide the new record details as follows:

Value Comments

Name PickList Country NXG Any name of customer choice

Project NXG
Any project of customer’s choice.
Preferably, the same project name, which is
used for custom repository can be provided.

Table 11–4 New Record Details
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Value Comments

Bounded TRUE Should be checked

Business Component PickList Hierarchical Should bementioned as is

No Delete, No Insert, No
Merge, No Update TRUE Should be checked

Type Field Type Should bementioned as is

Type Value STATE_ABBREV Should bementioned as is

12. Save the record by stepping off the record or Ctrl + S.

13. In Object Explorer Click on the object Business Component. It should display some list of available
records.

14. Query the business component in which the customer want this Picklist to be used.

15. The BC names are Personal Address and CUT Address. Do the steps from 16 to 21 for both the BCs:
Personal Address and CUT Address.

16. Expand this BC in the object explorer and click its field entity.

17. Query for the field Country.

18. Select Country field and do the following changes in it.

Property Name Value Comments

Picklist PickList Country NXG The new picklist which is created
in point 8 above.

Immediate Post
Changes TRUE Set this property to true

Table 11–5 Picklist County NXG

19. Expand this entity Field and select Pick Map. Create new records as mentioned below.

Name Constrain Picklist Field

Country NULL Value

State NULL NULL

Table 11–6 Picklist County NXG

20. Query for the field State.

21. Select State field and do the following changes in it.
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Property Name Value Comments

Picklist PickList Country NXG The new picklist which is created in Point 11
above.

Immediate Post
Changes TRUE Set this property to true

Table 11–7 Picklist Country NXG

22. Expand this entity field and select Pick Map. Create new records as mentioned below.

Name Constrain Picklist Field

Country TRUE Parent

State NULL Value

Table 11–8 New Record Details

23. Create the LOV Types if the LOV Types are not present in their OCH.

Seed Data:

With the abovementioned repository changes it is assumed that the customer has two LOV types with
names COUNTRY_CODE, and STATE_ABBREV in their custom repository.

If these LOV types are non-existent and if you want to create these new LOV types then follow the
below steps:

Creating New LOV Types:

The steps to create new List of Values are as follows:

a. Launch Siebel UCM Application with Proper Credentials.

b. Navigate to Site Map ->Administration Data->List of Values.

c. In the displayed list applet create two new records with the details below.

Type Replication Level

COUNTRY_CODE All

STATE_ABBREV All

Table 11–9 New record details

In case, if the customer wants to use Siebel Provided LOV types then you can ignore the above
section. However, they have tomention the correct LOV type, which they want to use in the Type
Value field in the Siebel Repository section in Points 8 and 11.

24. Add states for Australia to LOV:

Creating New LOV Types:

The steps to create new List of Values are as follows:
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a. Launch Siebel UCM Application with Proper Credentials.

b. Navigate to Site Map ->Administration Data->List of Values.

c. If Australia is not present in COUNTRY_CODE, then in the displayed list applet create new
records (new LOV values) for COUNTRY as below:

Type Display
Value

Language-
Independent
Code

Language
Name Parent LIC Order

COUNTRY_
CODE AU Australia English-

American NULL 13

Table 11–10 New LOV Values

25. Similarly, create new records (new LOV values) for STATES as below:

Type Display
Value

Language-
Independent
Code

Language
Name Parent LIC Order

STATE_
ABBREV NSW NSW English-

American Australia 1

STATE_
ABBREV NSW NSW English-

American Australia 2

STATE_
ABBREV TAS TAS English-

American Australia 3

STATE_
ABBREV NT NT English-

American Australia 4

STATE_
ABBREV WA WA English-

American Australia 5

STATE_
ABBREV SA SA English-

American Australia 6

STATE_
ABBREV ACT ACT English-

American Australia 7

STATE_
ABBREV VIC VIC English-

American Australia 8

Table 11–11 New record details

Note that the above list is not final. The customer has to add the records as per their requirement. Only key
point here is that the Parent LIC value should bementioned correctly.

Select the Parent LIC whose Type property is COUNTRY_CODE and Parent Display Value is AU (first
record as shown in the screenshot below).
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Figure 11–12 Pick Parent

11.6 Change of Picklist for Relationship
The New Picklist details are :

n Asset Account Relation PickList NXG

n Asset Contact Relation PickList NXG

The steps are as follows:

1. Launch Siebel Tools.

2. In the Object Explorer, select the object Project.

3. Right-click the record pane and select New Record to create new project if NXG is not present
already.

4. Provide the name as NXG. Set the property Locked to True.

5. Save the record by stepping off the record or Ctrl + S.

6. In Object Explorer, click the object Pick List. It should display a list of available records.

7. Right-click the record pane and select New Record. An empty record is created in the record pane.

8. Give the new record details as below:
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Value Comments

Name Asset Account Relation
PickList NXG Any name of customer’s choice.

Project NXG
Any project of customer’s choice. Preferably,
the same project name, which is used for
custom repository can be provided.

Bounded TRUE Should be checked

Static TRUE Should be checked

Business Component PickList Generic Should bementioned as is

No Delete, No Insert,
NoMerge, No Update TRUE Should be checked

Type Field Type Should bementioned as is

Type Value AUTO_ASSET_
ACCNT_REL Should bementioned as is

Table 11–12 New Record Details

9. Save the record by stepping off the record or Ctrl + S.

10. Save the record by stepping off the record or Ctrl + S.

11. Query the business component in which the customer want this Picklist to be used. The BC name is
FINCORP Account.

12. Expand this BC in the object explorer and click its field entity.

13. Query for the fieldRelationship.

14. Select theRelationship field and do the following changes in it.

Property Name Value Comments

Picklist Asset Account Relation PickList NXG The new picklist which is created
in Point 8 above

Table 11–13 Asset Account Relation PickList NXG

15. Expand this entity field and select Pick Map. Create new records as mentioned below.

Name Constrain Picklist Field

Relationship Value

Table 11–14 Asset Account Relation PickList NXG

16. Right-click the record pane and select New Record. An empty record will be created in the record
pane.

17. Provide the new record details as below:
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Value Comments

Name Asset Account Relation
PickList NXG Any name of customer choice

Project NXG
Any project of customer’s choice.
Preferably, the same project name, which
is used for custom repository can be
provided.

Bounded TRUE Should be checked

Static TRUE Should be checked

Business Component PickList Generic Should bementioned as is

No Delete, No Insert,
NoMerge, No Update TRUE Should be checked

Type Field Type Should bementioned as is

Type Value AUTO_ASSET_CON_REL Should bementioned as is

Table 11–15 New Record Details

18. Query the business component in which the customer want this Picklist to be used. The BC name is
FINCORP Account Contact.

19. Expand this BC in the object explorer and click its field entity.

20. Query for the field Type.

21. Select Type field and do the following changes in it.

Property Name Value Comments

Picklist Asset Contact Relation PickList
NXG

The new picklist which is created in
Point 17 above.

Table 11–16 Asset Contact Relation Picklist NXG

22. Expand this entity Field and select Pick Map. Create new records as mentioned below.

Constrain Picklist field

Type Value

Table 11–17 Picklist County NXG

11.7 OSC Server Configuration in OBP
OBP integrates with Oracle Sales Cloud (OSC) using the ICS integration and UI Mashup. TheOSC base
URL is present as part of seed data. For the integration to work, IP address and port of OSC server need to be
configured in OBP.

Following are the steps to configure OSC so that it can integrate with OBP:
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1. Log on to the admin URL of OBP using the username and password set in OID.

https://<hostserver>:<port>/com.ofss.fc.ui.view.admin/login.html

Figure 11–13 OBP Admin Login

2. Navigate to Configurations -> Configuration Variables Information (Fast Path: CFG01).

Figure 11–14 Navigate to Configurations
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Figure 11–15 Configuration Variables Information (Fast Path: CFG01)

3. Click Fetch Records.

4. Search the text: osc.*

Figure 11–16 Search osc.*

5. Update the server name and click Ok.
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Figure 11–17 Update Server Name

11.8 Registering OBP Cloud Adapter in ICS
For applications (OSC) using ICS integration pattern, OBP Cloud adapter needs to be registered in ICS Pod.
The steps for registering are as follows:

1. Changes to be done in setDomainEnv are as follows:

a. Navigate to the directory $INSTALL_DIR/ICSOP/data/user_projects/domains/expanded_
domain/bin.

b. Search for POST_CLASSPATH.

Add the following entry:

POST_
CLASSPATH="/scratch/app/product/ics/ICSOPInstall/ICSOP/app/Oracle/Middleware/Oracl
e_Home/soa/soa/modules/oracle.soa.common.adapters_
11.1.1/oracle.soa.common.adapters.jar${CLASSPATHSEP}/scratch/app/product/ics/ICSOPI
nstall/ICSOP/app/Oracle/Middleware/Oracle_Home/soa/soa/modules/oracle.cloud.adapter_
12.1.3/oracle.cloud.adapter.jar${CLASSPATHSEP}/scratch/app/product/ics/ICSOPInstall/IC
SOP/app/Oracle/Middleware/Oracle_Home/soa/soa/modules/oracle.cloud.adapter_
12.1.3/obpcloudadapter.jar${CLASSPATHSEP}${POST_CLASSPATH}"

export POST_CLASSPATH

c. Restart admin and ICS server.

2. Log in to ICS server using the following URL:

http://<icsserver>:<port>/ics/faces/icslogin.jspx
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Figure 11–18 ICS Server Login

3. Navigate to the Adapter tab.

Figure 11–19 Navigate to Adapter tab

4. Click Register and upload the adapter jar available in media pack.
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Figure 11–20 Register Adapter

After registration it should show the adapter as pre-installed when you search for the record.

Figure 11–21 Pre-installed Adapter

11 OBP and OCH-OSC Integration | 302



303 | Oracle Banking Platform Installation Guide - Silent Installation



12 BIP Datasource Creation

This chapter explains the steps required for Oracle Banking Platform BIP (BI Publisher) datasource creation.

12.1 BIP Datasource Creation
To use BIP, it is required to create datasource in BIP server. This can be done after Host pre-install. The data
sourcemust point to the same db schema as given in BIP_DATASOURCE_NAME in
installobphost.properties.

Follow the below mentioned steps to create the datasource:

1. Open a browser and navigate to:

<BIP_SERVER_IP>:<BIP_SERVER_PORT>/xmlpserver

2. Log on using the following credentials:

Username <BIP_SERVER_USER>

Password <BIP_SERVER_PSWD>
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Figure 12–1 BIP Server Console Login

3. After logging in, click Administration.
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Figure 12–2 BIP Administration

4. Click JDBC Connection underData Sources.
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Figure 12–3 BIP JDBC Connection

5. Click theAdd Data Source button.
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Figure 12–4 BIP - Add Data Source

6. Fill up the following fields:

Field Name Description

Data Source Name Any name can be given here

Driver Type Oracle 11g

Database Driver Class oracle.jdbc.OracleDriver

Connection String jdbc:oracle:thin:@<OBP_HOST_DB_IP>:<OBP_HOST_DB_
PORT>:<OBP_HOST_DB_SERVICE_NAME>

Username <BIP_DATASOURCE_NAME>

Password <OBP_HOST_DB_PASSWORD>

Table 12–1 Data Source Details

7. Click Ok.
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Figure 12–5 BIP Data Source Created
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13 ODI Configuration

This chapter details steps involved in the configuration of ODI. Before configuring ODI, you need to install the
required ODI versionmentioned in Section 3.1.2.1 Certification Details.

You can configure ODI using odi.tar.gz . ODI configuration zip is present inside the ob-utils zip/Insights.zip.

13.1 Configuration Procedure
Following are the steps required for ODI configuration using ob-utils zip/Insights.zip:

1. Createmaster and work repository using RCU. At the end of RCU run, master and work repository is
created in one schema.

2. Create a staging area to copy all the scenarios from ob-utils.zip\Insights.zip\odi.tar.gz\odi.tar.

3. Follow ODI Level Configurations mentioned in Section 16 Analytics Configuration.

4. Create data source for master and work repository with schema and DB details based on step 1.

n odiMasterRepository for Master Repository having JNDI name: jdbc/odiMasterRepository.

n odiWorkRepository forWork Repository having JNDI name: jdbc/odiWorkRepository.

5. Create threemore data sources in the ODI domain.

n odiOCSA for CSA DB having JNDI name: jdbc/odiOracleCsa

n odIUploadOBP for OBP DB having JNDI name: jdbc/odIUploadOBP

n odiOBP for source DB having JNDI name: jdbc/odiOBP

6. Deploy agent from staging area in ODI domain.

7. Create one data source to access reporting db (jdbc/FCBDataSourceODI) with the nameOBP_
HOST_ODI_XA in host domain where batch will run.

8. Make the entry forWSDL_URL in odi.properties file in host domain where batch will run.

Example: WSDL_URL =

http: //<ODIDOMAINSERVER>:8080/oracle12diagent/OdiInvoke?WSDL
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14 Swagger UI Deployment

This chapter explains the steps involved in the deployment of Swagger UI on the UI server.

Make the following changes in the scripts:

1. Unzip the files sequentially and locate the SwaggerUI folder.

ob-utils.zip\Add-ons-Utilities.zip\SwaggerUI.tar.gz\SwaggerUI.tar\SwaggerUI

Figure 12–6 Unzip files

2. Copy SwaggerUI folder to following path:

/scratch/app/product/fmw/obpinstall/obp/ob.ui.applications

3. Unzip yaml.zip to yaml folder.

For example, unzip yaml.zip -d

/scratch/app/product/fmw/obpinstall/obp/ob.ui.applications/SwaggerUI/yaml

4. Deploy folder as application through weblogic console.
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Figure 12–7 Deploy yaml folder

5. Click Lock & Edit and then click Deployments.
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Figure 12–8 Click Deployments

6. Click Install, browse the SwaggerUI, and click Next.

Figure 12–9 Click Install and Browse SwaggerUI

7. Deploy SwaggerUI as application.
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Figure 12–10 Deploy as application

8. Select the deployment target server (obpui_cluster1).

Figure 12–11 Select target

9. Enter the deployment name as SwaggerUI and click Finish.
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Figure 12–12 Enter deployment name

10. After clicking Finish, SwaggerUI deployment status is seen as Prepared.
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13.1 Configuration Procedure

Figure 12–13 Deployment status

11. Start it from theControl tab.

12. After SwaggerUI deployment, validate the deployment. SwaggerUI must be inActive state. If it is in
Prepared state, start it from the Control tab.

Figure 12–14 Active status in Control tab
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15 Monitoring Servers Using Oracle
Enterprise Manager

This chapter lists the steps required tomonitor servers using Oracle EnterpriseManager (EM).

TheOBP servers can bemonitored using Oracle EnterpriseManager (EM). ’em_monitor.zip’ is available
inside ’ob-utils’ for this purpose. The procedure is as follows:

1. Extract the ’ob-utils’ to get ’em_monitor.zip’.

2. Extract ’em_monitor.zip’. It contains ’obp_em_view_script’ folder.

For monitoring the OBP Servers, follow the procedures given in Oracle Banking Platform Management
Pack SetupGuide.
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16 Analytics Configuration

This chapter explains the configuration required to set up analytics. Oracle Business Intelligence Enterprise
Edition (OBIEE) (which is a separately licensed product) is used for performing analytics using the following
dashboards:

n Origination Analytics dashboard (OBIEE 11.1.1.9.0)

n Credit Monitor (LCM) dashboard (OBIEE 12.2.1.2.0)

16.1 ODI Import Master Repository
This section explains the process of importing ODI Master Repository.

16.1.1 Create Schema of ODI Master Repository
Create new database schema for ODI master repository with the help of DBA. Schema for master repository
can be create using ODI studio also.

16.1.2 Create New ODI Repository Login
To create a new ODI repository login:

1. Click File > New.

Figure 14–1 Create new repository

2. Provide the required details and click OK.
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16.1 ODI Import Master Repository

Figure 14–2 Enter repository details

16.1.3 Import Master Repository
To import ODI master repository:

1. Click File > New.

Figure 14–3 Import master repository

2. Provide the required details.

3. Select themaster repository zip file (/host/analytics.tar/analytics/historical/odi/Repositories) from file
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16.2 ODI Import Work Repository

system and click OK.

Figure 14–4 Select master repository zip file

Figure 14–5 Set password

16.2 ODI Import Work Repository
This section explains the process of importing ODI Work Repository.
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16.2 ODI Import Work Repository

16.2.1 Create New ODI Work Repository
To create a new ODI repository:

1. Log in to newly createmaster repository.

Figure 14–6 Log in to master repository

2. Click Topology > Repositories >Work Repositories.

3. Click New Work Repository.
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16.2 ODI Import Work Repository

Figure 14–7 Select new work repository

4. Check repository connection details and click Next.

Figure 14–8 Check repository details

5. Specify work repository name asWORKREP1. Password is optional. Then click Finish.
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16.2 ODI Import Work Repository

Figure 14–9 Specify repository name

16.2.2 Import ODI Work Repository
To import ODI work repository:

1. Log in to ODI master repository after selecting newly created work repository.

Figure 14–10 Log in to repository

2. Click Designer > Designer Menu > Import.
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3. Select Import Work Repository and click OK.

Figure 14–11 Import work repository

4. Select import mode as Synonym Mode INSERT.

5. Select option as Import as Zip File.

6. Select work repository zip file from file system
(/host/analytics.tar/analytics/historical/odi/Repositories)
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16.3 ODI Level Configuration

Figure 14–12 Select work repository zip

16.3 ODI Level Configuration
This section explains the configurations required at ODI level.

16.3.1 Setting Target Data Server in ODI Topology
Provide the db details for analytics database containing the stage, dimension and fact table in the OBP_
ANALYTICS data server under Topology.
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16.3 ODI Level Configuration

Figure 14–13 Set target data server

16.3.2 Setting Source Data Server in ODI Topology
Provide the db details for OBP source tables in the OBP_SRC data server tab under Topology.
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16.4 ODI Agent Deployment Configuration

Figure 14–14 Set source data server

16.4 ODI Agent Deployment Configuration
This section explains the configurations required for ODI agent deployment.

16.4.1 Update the Connection Details of Master Repository and Work
Repository
To update the details:

1. Log in toWebLogic console.

2. Click Services > Data Sources > odiMasterRepository
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16.5 OBI Configuration

Figure 14–15 Select odiMasterRepository

3. Click Connection Pool and update database connection details for the repository.

Figure 14–16 Update connection details

16.5 OBI Configuration
This section explains the configurations required for OBI.

16.5.1 Update the Analytics DB Details in the Repository
Analytics database details are updated in catalog file.Catalog file can be found in HOST installer zip in
analytics.tar.gz.Inside analytics.tar.gz, catalog files can be found at analytics/historical/obi/catalog location
and RPD files can be found at analytics/historical/obi/repository location. Catalog files are updated with the
help of Oracle BI Administration Tool
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16.5 OBI Configuration

Update the DB source name and the user credentials in the Connection Pool of the repository and set it to the
Analytics DB.

Figure 14–17 Update Analytics DB details

16.5.2 Add the Analytics DB TNS Entry
Add the TNS entry for the analytics DB in the tnsnames.ora file at location ORACLE_HOME/network/admin.

16.5.3 Upload the Repository to the OBI Server
Perform the following steps.

1. Log in to the OBI EM server console.

2. Navigate toBusiness Intelligence > coreapplication > Deployment > Repository tab.

3. Click Release Configuration.

4. Click Upload and select the repository to be uploaded.

5. Enter the repository password.

6. Click Apply.

7. Restart the OBI server components.
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16.5 OBI Configuration

Figure 14–18 Upload repository

16.5.4 Upload the Catalogs to the OBI Server
Perform the following steps.

1. Navigate to the Oracle Business Intelligence Sign In page and sign in.

2. Click Catalog and navigate toShared Folders > Components.

3. Click Unarchive in the Tasks Panel and select the Analyses catalog to upload the analyses to the OBI
server.

4. Click Unarchive in the Tasks Panel and select the Dashboards catalog to upload the dashboards to
the OBI server.

Figure 14–19 Upload catalogs

16.5.5 Create Schema Objects
Perform the following steps.
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16.6 Global Configuration

1. Run the SQL script from the following location onOBIEE schema. This creates the required
dimension, fact and other related database objects.

/host/analytics.tar/analytics/historical/db/run_script.sql

2. Run the SQL script from the following location on CSA database. This populates the records from OBP
database to common staging area.

/host/analytics.tar/analytics/historical/db/run_script_CSASchema.sql

16.6 Global Configuration
This configuration is required to set up all global parameters to execute ODI scenario. Following parameters
need to be configured. All the seed files are available in "/host/analytics.tar/analytics/ historical/odi/seed"
folder.

n WSDL url of ODI agent

n CredentialStore type

n ODI repository username

n ODI repository password

n Flag for ODI source database

Run flx_fw_config_all_b.sql to configure above parameters.

ODI agent server and port need to be configured. Please run flx_fw_config_var_b.sql.

16.7 Batch Configuration for Analytics
This section explains the batch configurations required for analytics.

n Analytics Batch Category:Run flx_batch_job_category_master.sql to configure analytics batch
category.

n Analytics Batch Code Type:Run flx_batch_job_code_type.sql to configure analytics batch code.

n Analytics Batch Group Category:Run flx_batch_job_grp_category.sql to configure analytics batch
group category.

n Analytics Category Batch Shell Dependencies:Run FLX_BATCH_JOB_SHELL_DEPEND.sql to
configure shell dependency.

n Analytics Category Batch Shell:Run flx_batch_job_shell_master.sql to configure analytics shell.

n Analytics Batch Job Type:Run flx_batch_job_type.sqlto configure analytics batch job type.

n Analytics Job Definition:Run flx_di_etl_job_definition.sql to configure analytics job definition.
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17 Post Installation Verification

This chapter lists the steps required to verify the Oracle Banking Platform solution installation.

17.1 UI Domain Verification
To verify the UI domain installation:

1. Start the UI domain Admin andManaged servers.

2. In theWebLogic console (<UI_IP>:<UI_ADMIN_PORT>/console), navigate to theSummary of
Deployments page.

3. Verify that theStatus of the following Oracle Banking Platform libraries and applications is Active.

Common (Applicable to all products)

n Shared Libraries

l ob.app.client.coll

l ob.app.client.communications

l ob.app.client.cz

l ob.app.client.deposit

l ob.app.client.fw

l ob.app.client.lcm

l ob.app.client.lending

l ob.app.client.or

l ob.app.client.party

l ob.app.client.pm

l ob.app.client.pricing

l ob.app.client.sh

l ob.ui.coll

l ob.ui.communications

l ob.ui.cz

l ob.ui.deposit

l ob.ui.fusion

l ob.ui.lcm

l ob.ui.lending

l ob.ui.or

l ob.ui.party
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17.1 UI Domain Verification

l ob.ui.pm

l ob.ui.pricing

l ob.ui.sh

l ob.ui.tp

l ob.ui.tp.cz

n Ears

l com.ofss.fc.app.monitoring

l com.ofss.fc.app.ui.connector

l com.ofss.fc.ui.rest.ops

l com.ofss.fc.ui.view.admin

l com.ofss.fc.ui.view.admin.dashboard

l com.ofss.fc.ui.view.developer

l com.ofss.fc.ui.view.qa

Oracle Banking Enterprise Product Manufacturing

n com.ofss.fc.ui.view.obepm

Oracle Banking Enterprise Collections

n com.ofss.fc.ui.view.obec

Oracle Banking Enterprise Originations

n com.ofss.fc.ui.view.obepm

n com.ofss.fc.ui.view.obeo

Oracle Banking Platform

n com.ofss.fc.ui.view

n com.ofss.fc.ui.view.obeo

n com.ofss.fc.ui.view.obepm
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17.1 UI Domain Verification

Figure 15–1 UI WebLogic Console
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17.1 UI Domain Verification

Figure 15–2 UI WebLogic Console

4. In EM console (<UI_IP>:<UI_ADMIN_PORT>/em), check the status of:

n Cluster

n Managed Servers

n Applications
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17.1 UI Domain Verification

Figure 15–3 UI EM Console Status Check

5. In (<UI_IP>:<UI_ADMIN_PORT>/wsm-pm/validator) and (<UI_IP>:<UI_MANAGED_PORT>/ wsm-
pm/validator) screens, all policies must appear.
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Figure 15–4 UI Admin wsm-pm Validator
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17.2 Host Domain Verification

Figure 15–5 UI managed wsm-pm validator

17.2 Host Domain Verification
To verify the Host domain installation:

1. Start the Host domain Admin andManaged servers.

2. Navigate to theSummary of Deployments page.

3. Verify that theStatus of the following Oracle Banking Platform libraries and applications is Active.

Oracle Banking Enterprise Product Manufacturing

n Shared Libraries

l ob.app.client.communications

l ob.app.client.cz

l ob.app.client.fw

l ob.app.client.lcm

l ob.app.client.party

l ob.app.client.pm
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l ob.app.client.pricing

l ob.app.client.sh

l ob.app.host.communications

l ob.app.host.cz

l ob.app.host.fw

l ob.app.host.lcm

l ob.app.host.pm

l ob.app.host.sh

l ob.app.host.tp

l ob.app.host.tp.cz

n Ears

l com.ofss.fc.app.connector

l com.ofss.fc.app.monitoring

l com.ofss.fc.messaging.pm

l com.ofss.fc.middleware.pm

l com.ofss.fc.module.rest.ops

l com.ofss.fc.reports.communications

l com.ofss.fc.webservices.pm

Oracle Banking Enterprise Collections

n Shared libraries

l ob.app.client.coll

l ob.app.client.communications

l ob.app.client.cz

l ob.app.client.fw

l ob.app.client.sh

l ob.app.host.coll

l ob.app.host.communications

l ob.app.host.cz

l ob.app.host.fw

l ob.app.host.sh

l ob.app.host.tp

l ob.app.host.tp.cz
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n Ears

l com.ofss.fc.app.connector

l com.ofss.fc.app.monitoring

l com.ofss.fc.messaging.collection

l com.ofss.fc.middleware.collection

l com.ofss.fc.module.rest.ops

l com.ofss.fc.reports.communications

l com.ofss.fc.webservices.collection

Oracle Banking Enterprise Originations

n Shared Libraries

l ob.app.client.coll

l ob.app.client.communications

l ob.app.client.cz

l ob.app.client.deposit

l ob.app.client.fw

l ob.app.client.lcm

l ob.app.client.lending

l ob.app.client.or

l ob.app.client.party

l ob.app.client.pm

l ob.app.client.pricing

l ob.app.client.sh

l ob.app.host.communications

l ob.app.host.cz

l ob.app.host.fw

l ob.app.host.lcm

l ob.app.host.or

l ob.app.host.party

l ob.app.host.pm

l ob.app.host.pricing

l ob.app.host.sh

l ob.app.host.tp

l ob.app.host.tp.cz
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n Ears

l com.ofss.fc.app.connector

l com.ofss.fc.app.monitoring

l com.ofss.fc.messaging.or

l com.ofss.fc.middleware.or

l com.ofss.fc.module.rest.ops

l com.ofss.fc.reports.communications

l com.ofss.fc.webservices.or

Oracle Banking Platform

n Shared libraries

l ob.app.client.coll

l ob.app.client.communications

l ob.app.client.cz

l ob.app.client.deposit

l ob.app.client.fw

l ob.app.client.lcm

l ob.app.client.lending

l ob.app.client.or

l ob.app.client.party

l ob.app.client.pm

l ob.app.client.pricing

l ob.app.client.sh

l ob.app.host.coll

l ob.app.host.communications

l ob.app.host.cz

l ob.app.host.deposit

l ob.app.host.fw

l ob.app.host.lcm

l ob.app.host.lending

l ob.app.host.or

l ob.app.host.party

l ob.app.host.pm

l ob.app.host.pricing
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l ob.app.host.sh

l ob.app.host.tp

l ob.app.host.tp.cz

n Ears

l com.ofss.fc.app.connector

l com.ofss.fc.app.monitoring

l com.ofss.fc.messaging

l com.ofss.fc.messaging.py

l com.ofss.fc.middleware

l com.ofss.fc.module.rest.ops

l com.ofss.fc.reports.communications

l com.ofss.fc.webservices

Figure 15–6 Host WebLogic Console
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17.2 Host Domain Verification

Figure 15–7 Host WebLogic Console

4. In (<HOST_IP>:<HOST_ADMIN_PORT>/wsm-pm/validator) and (<HOST_IP>:<HOST_
MANAGED_PORT>/ wsm-pm/validator) screens, all policies must appear.
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Figure 15–8 HOST admin wsm-pm validator
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17.3 SOA Domain Verification

Figure 15–9 HOSTmanaged wsm-pm validator

Additionally, the installer can verify the following:

n JMS Resources and Security Credentials

l Verify the creation of JMS resources Using admin console.

l Verify security credential mappings for resource adapter under obphost.

n OID Integration

l Verify that the users and groups are created underSecurity -->Myrealms --> Users And
Groups. This is one of the indicators of successful OID integration.

n SMS Policy Seeding

l Verify from logs under ${HOST_FWM}/obpoidinstall/PolicyStoreSetup/logs to ensure policy
seeding was complete.

l EM andOWSM should also be verified in host as in UI.

17.3 SOA Domain Verification
To verify the SOA domain installation:
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1. Start the SOA domain Admin andManaged servers (SOA and human task).

2. Navigate to theSummary of Deployments page.

3. Verify that theStatus of the following Oracle Banking Platform libraries and human task files with .ear
extension is Active.

Common (Applicable to all products)

n Shared Libraries

l ob.app.client.coll

l ob.app.client.communications

l ob.app.client.cz

l ob.app.client.deposit

l ob.app.client.fw

l ob.app.client.lcm

l ob.app.client.lending

l ob.app.client.or

l ob.app.client.party

l ob.app.client.pm

l ob.app.client.pricing

l ob.app.client.sh

l ob.ui.coll

l ob.ui.communications

l ob.ui.cz

l ob.ui.deposit

l ob.ui.fusion

l ob.ui.lcm

l ob.ui.lending

l ob.ui.or

l ob.ui.party

l ob.ui.pm

l ob.ui.pricing

l ob.ui.sh

l ob.ui.tp

l ob.ui.tp.cz

n Ears

l com.ofss.fc.app.ui.connector
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Oracle Banking Enterprise Product Manufacturing

n Ears

l com.ofss.fc.workflow.ui.batchexceptionrecovery

l com.ofss.fc.workflow.ui.brop

l com.ofss.fc.workflow.ui.common.approval

l com.ofss.fc.workflow.ui.hardshiprelief

Oracle Banking Enterprise Collections

n Ears

l com.ofss.fc.workflow.ui.batchexceptionrecovery

l com.ofss.fc.workflow.ui.brop

l com.ofss.fc.workflow.ui.CollectionWorkflowApplicationUI

l com.ofss.fc.workflow.ui.common.approval

l com.ofss.fc.workflow.ui.hardshiprelief

Oracle Banking Enterprise Originations

n Ears

l com.ofss.fc.workflow.ui.batchexceptionrecovery

l com.ofss.fc.workflow.ui.brop

l com.ofss.fc.workflow.ui.CapturePartyFinancialsHumanTask

l com.ofss.fc.workflow.ui.common.approval

l com.ofss.fc.workflow.ui.FeeNegotiationApprovalTask

l com.ofss.fc.workflow.ui.hardshiprelief

l com.ofss.fc.workflow.ui.lcm.PerformManualAllocationUITask

l com.ofss.fc.workflow.ui.lcm.valuation

l com.ofss.fc.workflow.ui.origination

l com.ofss.fc.workflow.ui.PartyMerge

l com.ofss.fc.workflow.ui.ProcessLoanRolloverHumanTask

Oracle Banking Platform

n Ears

l com.ofss.fc.app.ui.connector

l com.ofss.fc.workflow.ui.batchexceptionrecovery

l com.ofss.fc.workflow.ui.brop

l com.ofss.fc.workflow.ui.CapturePartyFinancialsHumanTask

l com.ofss.fc.workflow.ui.CollectionWorkflowApplicationUI

l com.ofss.fc.workflow.ui.common.approval
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l com.ofss.fc.workflow.ui.dda

l com.ofss.fc.workflow.ui.FeeNegotiationApprovalTask

l com.ofss.fc.workflow.ui.hardshiprelief

l com.ofss.fc.workflow.ui.lcm.PerformManualAllocationUITask

l com.ofss.fc.workflow.ui.lcm.valuation

l com.ofss.fc.workflow.ui.loans

l com.ofss.fc.workflow.ui.origination

l com.ofss.fc.workflow.ui.PartyMerge

l com.ofss.fc.workflow.ui.ProcessLoanRolloverHumanTask

4. Also verify that the standard SOA application soa-infra is inActive state.

Figure 15–10 SOA WebLogic Console
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17.4 BAM Installation Verification

Figure 15–11 SOA WebLogic Console

17.4 BAM Installation Verification
To verify the BAM installation:

1. Bring up the Admin andManaged servers (bam_server1).

2. Go to the BAM Login Page Link: http: //<BAM_IP>:9003/bam/composer/faces/designer
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17.4 BAM Installation Verification

Figure 15–12 BAM Composer
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17.4 BAM Installation Verification

Figure 15–13 BAM Composer
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17.5 BPM Worklist Window Setting

Figure 15–14 BAM Composer

Figure 15–15 BAM Composer

17.5 BPM Worklist Window Setting
For BPMWorklist window setting, the option Display task details in external windowmust be set to
enablemode. This option is present in administrationmode of BPMWorklist as shown in Figure 15–16.
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17.5 BPM Worklist Window Setting

Figure 15–16 BPMWorklist Window Settings
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18 Errors and Remedies

This chapter provides information on troubleshooting to help diagnose and remedy some of the problems
encountered during installation of the Oracle Banking Platform.

18.1 Oracle Banking Platform Domain Installation
In general, any environmental condition such as a network error that may lead to a halt in the installation is
evident to you on the console itself. You can additionally inspect WLST logs created in logs directory under
middleware for any anomalies.

While creating OBP SOA domain, ignore the following error:

Error: No domain or domain template has been read.

Error: No domain or domain template has been read.

Figure 16–1 OBP SOA Domain Error

The domain is created successfully. Also note that for recreation of SOA, Host, and UI domain, a new set of
RCUs is required, otherwise the pre-installation of respective component fails.

18.2 Oracle Banking Platform Security Policy Seeding
Formonitoring Oracle Banking Platform application security policy seeding, you can check the logs generated
in $HOST_FMW/obpoidinstall/PolicyStoreSetup/logs.

18.3 Oracle Banking Platform Domain Post Installation
This section lists various log files that assist in troubleshooting domain post installation as follows:

obp-* logs

During post installation in order to monitor errors, if any, you can check the obp-* logs created in the Oracle
Banking PlatformWebLogic domain. These logs contain adequate tracing information required to understand
the current execution point of the script. This facilitates to determine the various configurations that were
executed and those that need due action.

WebLogic Admin Server Logs and stderr file

The script does domain level configurations that require several automated reboots of admin server, which
can bemonitored by checking theWebLogic admin server logs and stderr file created under obp-domain-
dir/servers/AdminServer/stderr.log.
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For instance, consider a scenario of Oracle Banking Platform Host installation in which once the post install
script for Oracle Banking Platform host has secured itself against a LDAP (OID/OVD) it proceeds to restart
the Oracle Banking Platform Host domain admin server to produce these changes. During this if due to a
momentary network failure the host machine is unable tomake a connection to LDAP then the admin server
would fail to start. This will result in the post install script to abruptly abort throwing a subsequent script error
(again whichmight not conclusive enough to point out the root cause). The ’obp-*’ logs created in the Oracle
Banking Platform Host domain would indicate an incomplete attempt by post install script to start the admin
server.

You can check the admin server logs (to find why the admin server could not start) which will ultimately yield
out the actual reasons (in this case the reason being host machine was unable to connect to LDAP).

stderr log, WebLogic Domain Managed Server logs, OFSS logs

Once the post install script is completed successfully, you can start the domain servers and enter a dummy
transaction to check the system correctness. If you face an error you can inspect the stderr log, theWebLogic
domainmanaged server logs as well as the ofss logs under domain directory.

When you start themanaged servers post installation, theremay occur a lot of error printing in startup logs
that you can ignore. However, ensure that the status of the applications deployed on the components is active
and the server is in runningmode. Even if there are errors during startup of themanaged server, you can login
to the application successfully.

18.4 Error on First Log in
In the first log in after installation, the following pagemay appear or blank pagemay appear:
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Figure 16–2 Error on First Log In

In this case, remove the part of the url after ’/main.jspx’, and then hit the rest of the url (Example:
https://10.180.25.23:8001/com.ofss.fc.ui.view/faces/main.jspx) again.

18.5 Log in Issues
If there is a problem during logging in themain page, you can check whether the home branch and business
unit of the user in OID are the samewith the Host DB table. Use the following query to verify it in database:

select * from flx_cs_branches_b;
select * from flx_me_business_unit_b;

If there is mismatch between the database andOID, make change in OID tomatch with the database.

18.6 SOA Setup in Cluster
This section explains the error that can be encountered in SOA setup in Cluster, and its resolution.

18.6.1 "COMPONENTTYPE": invalid identifier error
Due to one of the one-off patches for SOA applied during the OBP installation, in SOA cluster environment,
the following error might be seen in SOA server logs.

Internal Exception: java.sql.SQLSyntaxErrorException: ORA-00904:
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"COMPONENTTYPE": invalid identifier
Though this is not a fatal kind of exception, it can be resolved by adding onemore column componenttype of
size 10with char type in soainfra schema for table cluster_master.

For example onOracle database user needs to run the following command on soainfra schema:

alter table cluster_master add (componenttype varchar2(10));

18.7 BIP Report Data Model Linkage Problem after Host Post
Installation Step
After editing a report, click themagnifying glass icon to select the datamodel associated with this report.
(Here in red indicates that the datamodel is not properly connected with the report or that the report is
not able to find themodel at the location that it is referring)

Figure 16–3 Selecting the Data model

Note

The above step is to be carried out in case the datamodel of a report
has not correctly linked with a report, after reports are deployed in BIP
server in Host Post Installation step.
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18.8 Oracle BAM Command Utility Issue
This is not an issue. This occurs if Oracle BAM is installed for the second time on the samemachine.

The followingmessage appears:

Oracle BAM CommandUtility [Build 19427, BAM Repository Version 2025] Copyright © 2002, 2015.

Oracle and/or its affiliates. All rights reserved.

java.lang.SecurityException: User: weblogic, failed to be authenticated.

[ErrorSource="javax.security.auth.login.LoginException: java.lang.SecurityException: User: weblogic, failed
to be authenticated."]

The solution or pre-requisite before a second installation is to alter the following file:

<MIDDLEWARE_HOME>/soa/bam/config/BAMICommandConfig.xml

In this file, remove the following tags:

<ICommand_Default_User_Name>weblogic</ICommand_Default_User_Name>
<ICommand_Default_
Password>HkFBFDf0t65Kuw9/I70cnwXPYIXKz/OElhl0ID+qjdw=</ICommand_
Default_Password>

18.9 BPM Worklist Task Issue
If the BPM Task [Humantask] is not working after installation and you get a backend error indicating access
denied, then:

1. Add the following parameters in setStartupEnv.sh for obphumantask_server1.

-
Djavax.xml.parsers.DocumentBuilderFactory=com.sun.org.apache.xerces.internal.jaxp.DocumentB
uilderFactoryImp

l -
Djavax.xml.transform.TransformerFactory=com.sun.org.apache.xalan.internal.xsltc.trax.Transformer
FactoryImpl

-
Djavax.xml.parsers.SAXParserFactory=com.sun.org.apache.xerces.internal.jaxp.SAXParserFactory
Impl

And jps-config.xml

<property name="trust.keystoreType" value="KSS"/>

<property name="trust.keyStoreName" value="kss://opss/trustservice_ks"/>

<property name="trust.trustStoreName" value="kss://opss/trustservice_ts"/>

2. Restart it.
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Figure 16–4 BPMWorklist Task issue

18.10 Artifacts Issue for SM500 page
If artifacts are not available for SM500, execute the load-artifacts.sh script present at the host installable path.

For example,

sh /scratch/install/ load-artifacts.sh

Figure 16–5 Artifacts Issue for SM500 page
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18.11 ra/FCRJConnectorSOA connector issue
If below mentioned error is faced on Humantask server, configuration shown in the below figure has to be
done to resolve issue.

Caused By: javax.resource.spi.ApplicationServerInternalException: Unable to get a connection for pool =
"ra/FCRJConnectorSOA", weblogic.common.resourcepool.ResourceUnavailableException: No resources
currently available in pool ra/FCRJConnectorSOA to allocate to applications. Either specify a time period to
wait for resources to become available, or increase the size of the pool and retry.

at weblogic.connector.outbound.ConnectionManagerImpl.getConnectionInfo
(ConnectionManagerImpl.java:458)

Set theMax Capacity size to 50 and Highest NumWaiters to 15 as shown in the below figure and redeploy
the connector on Humantask server.

Figure 16–6 Settings for javax.resource.cci.ConnectionFactory page

18.12 Humantask Startup Issue
If Humantask server is not coming up in runningmode after installation and if you face below mentioned error,

<Nov 21, 2017, 7:40:52,638 PMGMT+05:30> <Error> <Socket> <BEA-000403> <IOException occurred on
socket: Socket[addr=/10.180.35.5,port=57761,localport=7001]

weblogic.socket.MaxMessageSizeExceededException: Incomingmessage of size: '10000080' bytes
exceeds the configuredmaximum of: '10000000' bytes for protocol: 't3'.

weblogic.socket.MaxMessageSizeExceededException: Incomingmessage of size: '10000080' bytes
exceeds the configuredmaximum of: '10000000' bytes for protocol: 't3'

at weblogic.socket.BaseAbstractMuxableSocket.incrementBufferOffset
(BaseAbstractMuxableSocket.java:212)

at weblogic.socket.BaseAbstractMuxableSocket.incrementBufferOffset
(BaseAbstractMuxableSocket.java:188)

at weblogic.rjvm.t3.MuxableSocketT3.incrementBufferOffset(MuxableSocketT3.java:675)

at weblogic.socket.SocketMuxer.readFromSocket(SocketMuxer.java:1004)
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at weblogic.socket.NIOSocketMuxer.readFromSocket(NIOSocketMuxer.java:771)

Truncated. see log file for complete stacktrace

>

Update the setDomainEnv.sh configuration file by settingMaxMessageSize for server as,

EXTRA_JAVA_PROPERTIES="${EXTRA_JAVA_PROPERTIES} -
Dweblogic.MaxMessageSize=50000000"

export EXTRA_JAVA_PROPERTIES

18.13 Collection Mocking
By default collection is enabled in enterprise application. For mocking collection, perform the following steps:

1. Execute the following SQL queries in application database:

update flx_fw_config_all_b set prop_value='false' where prop_
id='collection.bootstrap' and category_id='root';

update flx_fw_config_all_b set prop_value='false' where prop_
id='collection.webservice.bootstrap' and category_id='root';

2. Update the setDomainEnv.sh configuration file on HOST server with the following parameters:

EXTRA_JAVA_PROPERTIES="${EXTRA_JAVA_PROPERTIES} -

DAdapterFactories:INS_COLLECTION_ADAPTER_MOCKED=true -

DAdapterFactories:PARTY_COLLECTION_ADAPTER_MOCKED=true -

DAdapterFactories:LN_COLLECTION_ADAPTER_MOCKED=true -

DAdapterFactories:LCM_COLLECTION_ADAPTER_MOCKED=true -

DAdapterFactories:ACCOUNT_COLLECTION_ADAPTER_MOCKED=true -

DAdapterFactories:DDA_COLLECTION_ADAPTER_MOCKED=true -

DAdapterFactories:AC_COLLECTION_ADAPTER_MOCKED=true -

DAdapterFactories:CS_COLLECTION_ADAPTER_MOCKED=true"

export EXTRA_JAVA_PROPERTIES

3. Restart the HOSTmanaged server.

18.14 DDA, Party and LOAN Mocking for OBEO installer
For DDA, Party and LOAN Mocking, perform the following steps:

1. Update the setDomainEnv.sh configuration file on HOST server with the following parameters:

EXTRA_JAVA_PROPERTIES="${EXTRA_JAVA_PROPERTIES} -

DAdapterFactories:ACCOUNT_DDA_MOCKED=true -

DAdapterFactories:ACCOUNT_LOAN_MOCKED=true -

DAdapterFactories:PARTY_ENTITLEMENT_ADPT_MOCKED=true "
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export EXTRA_JAVA_PROPERTIES

2. Restart the HOSTmanaged server.
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19 Uninstalling the Application

This chapter explains the process of uninstalling the Oracle Banking Platform.

19.1 Manual Uninstall
Currently an installed Oracle Banking PlatformWebLogic domain can be uninstalledmanually by removing
following directories:

n Manually deleteWebLogic domain (Middleware_Home/user_projects/domains) created from obpinstall
template.

n Clean upmiddleware directory for any files or folders containing obp in their names (simply run rm –rf
*obp* under middleware directory).

n For uninstalling any of the Oracle Banking Platform related database schemas run the RCU utility and
choose theDrop option.
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